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capitolo 1

Introduzione di Digi 001

Informazioni su Digi 001

Grazie per avere scelto Digi 001, una soluzione multipiattaforma per la produzione musicale,
multimediale e il design sonoro. La confezione di Digi 001 comprende:

< 11 CD di installazione comprende il software di registrazione Pro Tools LE, plug-in RTAS (Real-Time
AudioSuite) e guide in formato PDF

e La Guida introduttiva a Digi 001 illustra le procedure di installazione, configurazione e le
esercitazioni per l'utilizzo del softwareDigi 001

< Scheda PCI Digi 001 a 8 canali Optical 1/0 da collegare al dispositivo di I/0

« Dispositivo I/0 Digi 001 con collegamenti audio analogico, S/PDIF e MIDI

« Le alette per rack consentono di installare il dispositivo 1/0 in un rack standard da 19 pollici
< Cavo di collegamento del dispositivo I/O: collega la scheda PCI Digi 001 al dispositivo 1/0

< Cavo ottico: collega Digi 001 a un dispositivo audio ADAT o S/PDIF

» Scheda di registrazione Digidesign

Funzionalita di Pro Tools LE

Il software Pro Tools LE presenta le seguenti funzionalita:

« Registrazione e riproduzione di 24 tracce audio digitali mono (a seconda della potenza del
computer)

« Registrazione e riproduzione di 128 tracce MIDI

» Utilizzo del montaggio non lineare, ad accesso causale e automazione del missaggio

< Elaborazione audio con 5 plug-in RTAS per traccia, a seconda della potenza del computer
e Utilizzo di 5 insert e 5 mandate per traccia

* Routing su 32 bus

e Supporto per sessioni a 16 o 24 bit
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A Pro Tools LE consente di utilizzare il sistema per eseguire il missaggio o I'elaborazione di tracce audio
(elaborazione host). I computer con velocita di clock superiore consentono di ottenere un conteggio piu
elevato di tracce e una maggiore potenza di elaborazione dei plug-in.

Funzioni di Digi 001
Ingressi e uscite di Digi 001:

« 8 ingressi audio analogici, 2 con preamplificatori di microfono

Interruttore phantom 48V sui preamplificatori di microfono

« 8 uscite analogiche e uscita monitor stereo

Uscita cuffie stereo
« Ingresso ottico per 8 canali ADAT o per 2 canali S/PDIF
« Uscita ottica per 8 canali ADAT o per 2 canali S/PDIF

2 canali RCA per ingressi/ uscite digitali S/PDIF
« Ingresso e uscita MIDI per 16 canali MIDI 1/0

Inoltre, Digi 001 comprende un connettore footswitch per il punch in e il punch out durante la
registrazione.

Requisiti di sistema

Il dispositivoDigi 001 puo essere installato su un computer Power Macintosh o Intel.

Per utilizzare Pro Tools LE su un computer Macintosh, occorre:

e Un Power Macintosh approvato da Digidesign (G4 consigliato)

e Mac0S9.009.1

* Almeno 128 MB di RAM (consigliati 192 MB)

e Unita CD-ROM per l'installazione del software

* QuickTime 4.0 o versione successiva (incluso nel software Pro Tools LE)

* OMS 2.3.8 o versione successiva (incluso nel software Pro Tools LE)

Per utilizzare Pro Tools LE con Windows, occorre:

e Un computer Intel approvato da Digidesign (PIlI consigliato)
* Windows Millennium Edition o Windows 98, Second Edition
* Almeno 256 MB di RAM

e Unita CD-ROM per l'installazione del software
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Informazioni sulla compatibilita

Digidesign ¢ in grado di garantire la compatibilita e fornire il supporto unicamente per il materiale

hardware e software collaudato e approvato. Per un elenco dei computer, dei sistemi operativi e dei
dispositivi di altri produttori approvati da Digidesign, consultare le informazioni sulla compatibilita
piu recenti nel sito Web di Digidesign:

www.digidesign.com/compato/

Registrazione Digidesign

Compilare e restituire la scheda di registrazione fornita con Digi 001. Gli utenti registrati hanno
diritto a un anno di supporto gratuito e riceveranno periodicamente avvisi sugli aggiornamenti del
software.

Informazioni sulle Guide
La Guida all'avvio rapido offre una panoramica sull'utilizzo di Digi 001 per la registrazione, I'editing
e il missaggio di tracce audio multiple e MIDI. Per ulteriori informazioni consultare le guide in linea:

* Guida di riferimento di Pro Tools: illustra in dettaglio le funzionalita e I'utilizzo del software
Pro Tools LE

e Guida ai Plug-In DigiRack: spiega come utilizzare i plug-in RTAS e AudioSuite inclusi in Pro Tools LE

* Guida delle superfici di controllo MIDI: spiega come utilizzare superfici di controllo MIDI, quali
Mackie HUI, con il softwarePro Tools LE

« Tasti di scelta rapida (per Macintosh e Windows): contiene un elenco di tasti di scelta rapida da
utilizzare in Pro Tools LE

Le versioni in formato PDF di queste guide vengono installate automaticamente con Pro Tools LE e
sono accessibili dal menu Help di Pro Tools LE. Per consultare le guide in linea o stamparle, &
necessario installare Acrobat Reader (incluso nel CD Installer di Pro Tools LE).

Capitolo 1: Introduzione di Digi 001



Convenzioni utilizzate nella presente guida

Nei manuali Digidesign vengono utilizzate le seguenti convenzioni per indicare le scelte di menu e i

comandi principali:

Convenzione

Azione

File > Save Session

Scegliere Save Session dal menu File

Control+N

Tenere premuto il tasto Control e contemporaneamente premere il tasto N

Opzione e clic

Tenere premuto il tasto Opzione e fare clic col pulsante del mouse

Fare clic con il pulsante destro
del mouse (Windows)

Fare clic con il pulsante destro del mouse

I seguenti simboli sono utilizzati per evidenziare informazioni importanti:

Q I suggerimenti per gli utenti sono dei consigli utili che consentono di ottenere il massimo

dal sistema.

A Le avvertenze importanti riportano informazioni che potrebbero influire sui dati e sulle

prestazioni del sistema.

I riferimenti incrociati rimandano a sezioni correlate in altre guide Digidesign.

Scegliere e selezionare

Le parole "scegliere" e "selezionare" sono spesso intercambiabili nella lingua colloquiale, mentre nella
presente guida viene fatta una distinzione precisa tra i due termini.

Selezionare Quando nella guida viene chiesto di selezionare qualcosa, I'elemento in questione rimane
selezionato. E il caso delle opzioni delle finestre di dialogo e delle voci di menu che attivano o

disattivano un'opzione.

Scegliere Quando nella guida viene chiesto di scegliere qualcosa, viene eseguita un‘operazione
univoca. E il caso della maggior parte dei comandi di menu, che consentono di eseguire I'azione scelta

una sola volta.
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capitolo 2

Configurazione dei sistemi Macintosh

Installazione dell'hardware Digi 001

Prima di installare il software Pro Tools LE, si consiglia di installare la scheda PCI Digi 001.

Per installare la scheda PCI Digi 001 nel Macintosh:

1 Spegnere il computer. Lasciare il cavo di alimentazione collegato per stabilire la massa a terra.

2 Aprire il coperchio del computer. Se occorre, consultare le istruzioni del produttore per ulteriori
informazioni.

3 Rimuovere lo sportello posteriore dello slot e le viti da tutti gli slot di espansione PCI disponibili.

Installazione della scheda PCI nel Macintosh

4 Prima di maneggiare la scheda PCI Digi 001, scaricare l'elettricita statica toccando la parte esterna
dell'alimentatore.

5 Rimuovere la scheda PCI Digi 001 dalla confezione antistatica.

6 Maneggiare con cura la scheda tenendola per le estremita superiori e allineare il connettore PCI con
lo slot PCI nel computer.
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7 Quando il connettore e lo slot sono stati allineati, inserire la scheda nello slot applicando una
pressione costante. La scheda dovrebbe scattare in posizione. Fissare la scheda con la vite
precedentemente rimossa. Verificare che i connettori audio della scheda siano accessibili dallo slot
posteriore del computer.

Scheda PCI Digi 001

Slot PCI libero nel computer

Installazione della scheda PCI

8 Chiudere il coperchio del computer.

Collegare il dispositivo Digi 001 170

A Il computer deve essere spento quando si collega o scollega il dispositivo /0.
Per collegare il dispositivo Digi 001 1/0:
1 Individuare il cavo di connessione con le estremita larghe fornito con Digi 001.

2 Allineare un'estremita del cavo con il connettore sulla scheda PCI Digi 001 e inserire il cavo facendo
pressione finché non scatta in posizione.

(f : \')
]

T
Collegare qui il cavo

Il connettore per il cavo sulla scheda PCI Digi 001 (vista dall'esterno del computer)

3 Allineare l'altra estremita del cavo con il connettore del computer sul dispositivo 1/0 Digi 001 e
inserire il cavo nel connettore facendo pressione finché non scatta in posizione.

= 000

ot our ROTSW  WAUT4  WPUTE  WeUTe

1
Collegare qui il cavo

4 Accendere il computer.
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Installazione del software Pro Tools LE

Impostazioni software del sistema Apple

Per garantire prestazioni ottimali con il software Pro Tools LE, configurare il software del sistema
Apple utilizzando le seguenti impostazioni.

Per configurare il software del sistema Apple:

1 Nel Pannello di Controllo Memoria effettuare le seguenti impostazioni:

e Impostare la Memoria virtuale su Off.

Impostare Disco Ram su Off.

Impostare la Memoria Tampone su Impostazioni ad hoc 512K.

2 Nel Pannello di controllo Risparmio energia, nel riquadro Metti il sistema in stop se rimane inattivo
per, selezionare Mai.

3 Nel Pannello di Controllo Ambiente effettuare le seguenti impostazioni:

Fare clic sulla scheda Font e impostare Font di sistema grande su Chicago. Inoltre deselezionare
Arrotonda i font sullo schermo.

Fare clic sulla scheda Suoni e selezionare Nessuno dal menu a comparsa Effetti sonori.

4 Impostare il numero di colori su Migliaia nel Pannello di Controllo Monitor e Suono. Se si utilizza
un Power Macintosh 9600, impostare il numero di colori su 256.

5 Nel Pannello di Controllo Gestione Estensioni effettuare le seguenti impostazioni:

0 =———————Extensions Manager =—-7-—— 018
@ Mac 05 9.0 All
Selected Set: © Mac 05 9.0 Base ) 2
On/Off SizeIVersion IPackage =
Energy Saver 198K 2.1.2 Mac 05 8.6 -~
File Exchange 627K 3.0 Mac 05 8.6
File Sharing G4k 5.0 Mac 05 8.5
Flash-1t 3.0.2 53K 3.0.2 Flash-1t 3.0.2
General Controls S0k 774 Mac 05 8.5
| Internet 330K 1.0 Mac 05 8.5
lamega Drive Options 825K 1.4.4 lomegatare ...
Key board S0K 8.2 Mac 05 5.6 -
| Restart | | Revert | [ Duplicate Set.. |
[» Shew Item Information 2

Pannello di Controllo Gestione Estensioni
« Scegliere Mac OS 9.0 base (0 Mac OS 9.1 base) dal menu a comparsa Gruppo selezionato.

« Fare clic su Riavvia per riavviare il computer.
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Installazione di Pro Tools LE

Una volta configurate le impostazioni del software del sistema Apple, installare Pro Tools LE.

Per installare Pro Tools LE sul Macintosh:

1 Inserire il CD di installazione di Pro Tools LE nell'unita CD-ROM. Fare doppio clic su Install
Pro Tools LE.

i

Install Pro Tools LE

2 Nella finestra Install selezionare I'opzione di installazione per Pro Tools LE e impostare il percorso
di installazione sul disco rigido di avvio. Fare clic su Install.

3 Seguire le istruzioni visualizzate sullo schermo.

4 Unavolta completata I'installazione, fare clic su Smetti (non su Riavvia) e installare le sessioni demo
(vedere "Installazione della sessione demo" a pagina 8) e OMS (vedere "Installazione e configurazione
di OMS" a pagina 9).

Installazione della sessione demo

Il sistema Digi 001 comprende due sessioni demo, Pro Tools SoundCheck DigiO01, che puo essere usata
per verificare il corretto funzionamento del sistema, e Be There DigiO01, una demo pit completa che
puo essere usata per testare il sistema di riproduzione e per imparare alcune funzioni di Pro Tools LE
mediante l'esercitazione contenuta nel Capitolo 5, "Utilizzo della sessione demo".

A Prima di installare le sessioni demo nell'unita audio, verificare che I'unita sia configurata
come descritto nella sezione "Requisiti del disco rigido" a pagina 12.

Per installare le sessioni demo:

1 Inserire il CD di installazione di Pro Tools LE nell'unita CD-ROM. Fare doppio clic su Install PT LE
Demo Session.

2 Nella schermata di installazione assicurarsi che siano selezionate le opzioni di installazione per "Be
There Session" e "SoundCheck Session".

3 Impostare il percorso di installazione sull'unita audio e fare clic su Install.

4 Al termine dell'installazione fare clic su Smetti.
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Installazione e configurazione di OMS
(Solo Macintosh)

Per utilizzare Pro Tools nel Macintosh occorre prima installare e configurare Open Music System
(OMS). OMS, incluso nel CD di installazione di Pro Tools, presenta le seguenti funzionalita:

= Consente di sapere quali dispositivi MIDI sono in uso, come sono collegati e quali patch vengono
utilizzati

e Consente all'hardware MIDI di comunicare con le applicazioni musicali

« Fornisce servizi di sincronizzazione e di comunicazione tra le applicazioni

Con l'applicazione OMS viene memorizzata una descrizione dell'impianto MIDI nei documenti Studio
Setup modificabili nell'applicazione OMS Setup. Una volta configurato OMS, le applicazioni musicali
utilizzate sono in grado di "sapere" quali dispositivi MIDI vengono usati facendo riferimento al
documento di Studio Setup corrente.

Le sezioni riportate di seguito forniscono istruzioni di base relative all'installazione e alla
configurazione di OMS. Per ulteriori informazioni consultare il manuale in linea OMS Guide installato
con Pro Tools.

Installazione di OMS

Il programma di installazione di OMS si trova nel CD di installazione di Pro Tools.

Per installare OMS:

1 Inserire il CD di installazione di Pro Tools nell'unitd CD-ROM.
2 Aprire la cartella OMS Installer e fare doppio clic sul programma di installazione di OMS.

3 Nella finestra Install selezionare I'opzione Easy Install e impostare il percorso di installazione sul
disco rigido di avvio. Fare clic su Install.

4 Seguire le istruzioni visualizzate sullo schermo.

5 Una volta completata l'installazione, riavviare il Macintosh.
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Configurazione di una nuova impostazione (New Studio Setup)
(Solo utenti che utilizzano OMS per la prima volta)
Prima di configurare OMS, verificare che Digi 001 e il dispositivo I/O siano stati installati e che

qualsiasi altra interfaccia MIDI sia collegata in conformita con le istruzioni del produttore e che siano
accesi.

Per configurare una nuova impostazione New Studio Setup in OMS:

1 Awvviare l'applicazione OMS Setup. Se OMS non é stato ancora configurato, verra chiesto di
configurare un nuovo New Studio Setup. Fare clic su OK.

2 Specificare se l'interfaccia MIDI ¢ collegata alla porta del modem o della stampante. Se si utilizza
un'interfaccia MIDI di tipo USB o PCI (compreso Digi 001), non selezionare le due porte. Fare clic su
Search.

OMS Driver Search

OMS will now searen for MIDI cards, interfaces, and software
synthesizers. These devices are controlled by drivers

Click to check the external parts to search for MIDI inferfaces:

[m} Madem =

Printer

Porte per la ricerca del driver OMS

Vengono cercati e visualizzati le interfacce MIDI, le schede MIDI e i driver OMS. Se l'interfaccia
utilizzata non viene individuata, fare clic su Troubleshoot. Una volta individuata la propria
interfaccia, viene chiesto di cercare gli strumenti MIDI collegati all'interfaccia.

3 Fare clic su OK per cercare i dispositivi MIDI collegati all'interfaccia MIDI. Per essere individuato, il
dispositivo deve essere acceso con entrambe le porte MIDI collegate all'interfaccia.

OMS Driver Setup

M3 has detected the following devices i nstalled on your computer. This
list does net include external MIDI devices like sound medules, keyboards,
and drum machi nes.

&3 sampleCell .

Digi 001
&3 14T Driver

Click “0K= if this list is correct. Click “Troubleshoot™ if this list is
incorrect or incomplete. Click “Customize™ to add drivers manually.
Click “Cance|” to abort OMS setup.

(_cancel ] (_customize | [Troubleshoot] [ ok ||

Schermata OMS Driver Setup
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I dispositivi MIDI individuati vengono visualizzati. Pud darsi che alcuni degli strumenti meno
recenti, nonché alcuni di quelli pit nuovi, non vengano riconosciuti dalle routine automatiche di
individuazione di OMS.

=l

Dispositivo OMS non riconosciuto

I dispositivi non riconosciuti da OMS vengono visualizzati con un punto di domanda rosso e viene
assegnato loro un nome in base all'interfaccia o alla porta alla quale sono collegati. Questi dispositivi
possono essere definiti come necessari all'interno dell'applicazione OMS Setup (vedere la sezione
"Definizione dei dispositivi MIDI in OMS" a pagina 11).

4 Fare clic su OK per salvare il documento Studio Setup.

Definizione dei dispositivi MIDI in OMS

Per definire un dispositivo MIDI in OMS Setup:

1 Fare doppio clic sull'icona del dispositivo desiderato nella finestra Studio Setup.

2 Nella finestra di dialogo MIDI Device Info selezionare il produttore e il modello del dispositivo dai
menu a comparsa. Se il dispositivo non e elencato, lasciare I'impostazione (other) per il modello e
immettere il nome del dispositivo.

MIDI Device Info

l“i:'-“ Manuf:[ (other) |

Model:| (other) + | Device ID: 0

Name:|unknuwn |

Receives Sends

[ Is controller MID1 Time Code

. MID| Beat Clock | |
Is multitimbral
o MID| Machine Control| ||

Receive Channels
1 2 2 4 5 & 7 8 9 10111212 14 15 16

[ Cancel ]l] 0K ]I

Informazioni sul dispositivo MIDI

3 Selezionare il canale ricevente per il dispositivo. Se si ricevono piu canali, selezionare I'opzione Is
Multitimbral.

4 Se si registra utilizzando il dispositivo in Pro Tools, selezionare I'opzione Is Controller. Se il
dispositivo sara una sorgente o una destinazione per MIDI Time Code, Beat Clock o MIDI Machine
Control, selezionare I'opzione adeguata.

5 Fare clic su OK.
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Disattivazione di Serial DMA in OMS

In Pro Tools & necessario deselezionare I'opzione Use Apple Serial DMA Driver When Available in
OMS Setup. Se non si disattiva questa opzione, si verificheranno problemi con le funzioni di
sincronizzazione e MIDI di Pro Tools.

Per disattivare Serial DMA in OMS:

1 Fare doppio clic sull'applicazione OMS Setup.

2 Scegliere Edit > Preferences.

3 Deselezionare I'opzione Use Apple Serial DMA Driver When Available e fare clic su OK.

4 Uscire da OMS Setup.

Requisiti del disco rigido

Per la registrazione e la memorizzazione in Macintosh, Pro Tools LE richiede una o piu unita
approvate ATA/IDE o SCSI con le seguenti caratteristiche:

« Formattazione con file system HFS o HFS+

« Velocita di trasmissione dati di 3 MB al secondo o piu veloce

« Velocita di rotazione dell'unita di 7.200 RPM o piu veloce

e Tempo di ricerca medio di 10,0 millisecondi o piu veloce

Per informazioni piu aggiornate sulla compatibilita con il disco rigido e gli adattatori bus
host (HBA) SCSI, visitare il sito Web di Digidesign (www.digidesign.com/compato/).

Utilizzo di unita di sistema per la registrazione e la riproduzione audio

Sebbene con Pro Tools sia possibile registrare dall'unita di sistema, solitamente questa procedura non
e consigliata. Le prestazioni per la registrazione e la riproduzione su dischi rigidi di sistema risultano
peggiori rispetto ai dischi rigidi non di sistema, con un numero inferiore di tracce e di plug-in.

Si consiglia di registrare sulle unita di sistema solo quando é assolutamente necessario; ad esempio se
il computer utilizzato € dotato di una sola unita disco rigido o se le altre unita disco rigido non
dispongono di spazio libero.

Dischi rigidi SCSI

Le unita SCSI presentano numerosi vantaggi rispetto alle unita ATA/IDE. In primo luogo le unita SCSI
possono essere anche esterne e quindi rappresentano un supporto di memorizzazione audio portatile
che puo essere trasferito facilmente da un sistema all'altro. In secondo luogo consentono di ottenere
prestazioni leggermente migliori per quanto riguarda la registrazione su un numero elevato di tracce;
se si cerca di registrare un numero elevato di tracce con un'unitd ATA/IDE, si verifichera un breve
ritardo prima dell'inizio della registrazione.
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Inizializzazione e deframmentazione delle unita

Si consiglia di lavorare con un'unita audio appena inizializzata. Occorre anche eseguire
periodicamente la deframmentazione dell'unita audio per ottenere prestazioni del sistema costanti.

Con un'unita SCSI é possibile utilizzare il software ExpressPro-Tools di ATTO (compreso nel CD di
installazione Pro Tools LE) per inizializzare I'unita. Con un disco rigido ATA/IDE si consiglia di
utilizzare I'utilita Drive Setup in dotazione con il software del sistema Apple.

Spazio di memorizzazione su disco rigido

Tracce audio mono registrate con una risoluzione di 16 bit a 44,1 kHz (qualita audio CD) richiedono
circa 5 MB di spazio su disco rigido al minuto. Le stesse tracce registrate a una risoluzione di 24 bit
richiedono circa 7,5 MB al minuto. Nella tabella seguente vengono elencati i requisiti di spazio su
disco rigido di determinati numeri e lunghezze di traccia. Per la scelta della quantita di spazio
necessaria sull'unita disco rigido, tenere in considerazione i dati riportati nella seguente tabella.

Spazio su disco rigido richiesto per tracce audio

Numero di tracce e lunghezza 16 bit a 16 bit a 24 bita 24 bita
44,1 kHz 48 kHz 44,1 kHz 48 kHz

1 traccia mono, 1 minuto 5 MB 5,5 MB 7,5 MB 8,2 MB

1 traccia stereo (o due tracce 50 MB 55 MB 75 MB 83 MB

mono), 5 minuti

1 traccia stereo (o due tracce 600 MB 662 MB 900 MB 991 MB

mono), 60 minuti

24 tracce mono, 5 minuti 600 MB 662 MB 900 MB 991 MB

24 tracce mono, 60 minuti 7 GB 7,8 GB 10,5 GB 11,6 GB

Awvio di Pro Tools LE per la prima volta

Immissione del numero di serie

Quando si avvia Pro Tools LE per la prima volta, viene chiesto di immettere il numero di serie.

Please enter the serial number provided with this version of Pro Tools:

[ | (Ccancer] [[validate ]

Immissione del numero di serie per Pro Tools

Il numero di serie € riportato nella copertina interna della presente guida. Immettere il numero di serie
nella finestra di dialogo, osservandone gli spazi e I'uso delle maiuscole, quindi fare clic su Validate.

Capitolo 2: Configurazione dei sistemi Macintosh
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Configurazione dei sistemi Windows

Modifiche del BIOS e del sistema

Prima di procedere all'installazione dell'hardware o del software, occorre modificare alcune
impostazioni del BIOS e del sistema. Tali modifiche sono necessarie per garantire prestazioni ottimali
del software Pro Tools LE in Windows.

Impostazioni del BIOS

I diversi produttori di BIOS spesso utilizzano nomi diversi per descrivere le stesse funzioni del sistema
oppure in alcuni casi non forniscono alcuna configurazione alternativa. | nomi e le opzioni presenti
nel BIOS del computer potrebbero essere diverse da quelle presenti in questo manuale.

Apportare le seguenti modifiche alle impostazioni del BIOS del computer:

1 Accendere il computer; se & gia acceso, riavviarlo.

2 Durante l'avvio entrare in BIOS Setup premendo l'apposito tasto sulla tastiera (generalmente viene
indicato nel messaggio d'avvio). Nella maggior parte dei computer puo corrispondere al tasto F1, F2
o Canc.

3 Nell'apposita pagina dell'utilita BIOS Setup, disattivare PCI Parity. Se I'opzione PCI Parity non &
disponibile, saltare questo passaggio.

4 Salvare le modifiche, uscire da BIOS Setup e riavviare il computer.
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Impostazioni di sistema per Windows

In Windows configurare le seguenti impostazioni nel Pannello di controllo.

Disattivare la Notifica di inserimento automatico per le unita CD-ROM e le unita rimovibili:

1 Fare clic con il tasto destro del mouse sull'icona Risorse del computer sul desktop, quindi scegliere
Proprieta dal menu a comparsa visualizzato.

2 In alternativa scegliere Sistema nel Pannello di controllo, quindi fare clic sulla scheda Gestione
periferiche.

3 Fare doppio clic sull'icona dell'unita CD-ROM. Nella finestra di dialogo Proprieta CD-ROM fare clic
sulla scheda Impostazioni.

4 Deselezionare I'opzione di Notifica di inserimento automatico, quindi fare clic su OK.

5 Ripetere questi passaggi per tutte le unita rimovibili presenti nel sistema, quali le unita CD-R, CD-RW,
Jaz e Zip.

6 Al termine, chiudere il Pannello di controllo.

Attivare la modalita DMA per tutte le unita disco rigido IDE:

1 Fare clic con il tasto destro del mouse sull'icona Risorse del computer sul desktop, quindi scegliere
Proprieta dal menu a comparsa visualizzato.

2 In alternativa scegliere Sisterna nel Pannello di controllo, quindi fare clic sulla scheda Gestione
periferiche.

3 Fare doppio clic sull'icona dell'unita disco rigido IDE. Nella finestra di dialogo delle proprieta
dell'unita disco fare clic sulla scheda Impostazioni.

4 Selezionare l'opzione per la modalita DMA e fare clic su OK.
5 Ripetere questa operazione per le unita IDE aggiuntive.

6 Al termine, chiudere il Pannello di controllo.

Altri componenti software e hardware che possono influire sulle prestazioni del sistema
Le prestazioni del software Pro Tools LE possono anche dipendere da altri software o driver hardware
installati nel computer. Per garantire una corretta esecuzione del programma, si consiglia di:

« Non eseguire altre applicazioni Windows contemporaneamente a Pro Tools LE.

e Chiudere tutte le utilita software che vengono eseguite in background, quali calendari e programmi
antivirus.

= Disattivare i suoni di sistema di Windows. In Monitor e Suono nel Pannello di controllo impostare la
Combinazione di suoni su Nessun suono.

« Se la scheda video supporta la modalita Bus Mastering, attivarla nel pannello di controllo del produttore.

« Disattivare tutte le schede di rete.
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Installazione dell’'hardware Digi 001

Prima di procedere all'installazione dell'hardware Pro Tools LE, installare la scheda Digi 001.

Per installare la scheda Digi 001 su computer Intel:

1 Spegnere il computer. Lasciare il cavo di alimentazione collegato per stabilire la massa a terra.

2 Aprire il coperchio del computer. Se occorre, consultare le istruzioni del produttore per ulteriori
informazioni.

3 Rimuovere lo sportello posteriore dello slot e le viti da tutti gli slot di espansione PCI disponibili.

4 Prima di maneggiare la scheda Digi 001, scaricare I'elettricita statica toccando la parte esterna
dell'alimentatore.

5 Rimuovere la scheda Digi 001 dalla confezione antistatica.

6 Maneggiare con cura la scheda tenendola per le estremita superiori e allineare il connettore PCI con
lo slot PCI nel computer.

Installazione di una scheda PCI su un computer Intel

Capitolo 3: Configurazione dei sistemi Windows
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7 Quando il connettore e lo slot sono stati allineati, inserire la scheda nello slot applicando una
pressione costante. La scheda dovrebbe scattare in posizione. Fissare la scheda con la vite
precedentemente rimossa. Verificare che i connettori audio della scheda siano accessibili dallo slot
posteriore del computer.

Scheda Digi 001

Slot PCI libero nel computer

Installazione della scheda PCI

8 Riposizionare il coperchio del computer.

Collegare il dispositivo Digi 001 170

A E necessario che il computer sia spento quando si collega o scollega il dispositivo 1/0.
Per collegare il dispositivo Digi 001 1/0:
1 Individuare il cavo di connessione con le estremita larghe fornito con Digi 001.

2 Allineare un'estremita del cavo con il connettore sulla scheda Digi 001 PCI e inserire il cavo facendo
pressione finché non scatta in posizione.

Collegare qui il cavo

Il connettore per il cavo sulla scheda Digi 001 PCI (vista dall'esterno del computer)

3 Allineare l'altra estremita del cavo con il connettore del computer sul dispositivo Digi 001 1/0O e
inserire il cavo nel connettore facendo pressione finché non scatta in posizione.

10) s elele
[==1 ©©

spo woim ot Ut ROTSW  WRUT4  NPUTE  WPUT 18 hamourural outeurs  oureurs  oureurs

t
Collegare qui il cavo

4 Accendere il computer.

18 Guida introduttiva a Digi 001



Installazione dei driver Wave di Windows

Dopo aver installato la scheda Digi 001 e acceso il computer, viene visualizzata la finestra di dialogo
Installazione guidata nuovo hardware per l'installazione dei driver Windows richiesti.

Per installare i driver wave di Windows:

1 Quando viene visualizzata la schermata Installazione guidata nuovo hardware, fare clic su Avanti.

Add New Hardware Wizard

This wizard searches for new drivers for:

PCI Multimedia Audia Device

& device diiver is a software program that makes a
hardware device wark.

vk [owe ] cancel |

Installazione guidata nuovo hardware, Windows

2 Quando viene chiesto come si desidera procedere, selezionare I'opzione Visualizza un elenco dei
driver disponibili, quindi fare clic su Avanti.

3 Dall'elenco visualizzato selezionare Controller audio, video e giochi, quindi fare clic su Avanti.
4 Inserire il CD Pro Tools LE e fare clic su Disco driver.

5 Fare clic su Sfoglia. Individuare e selezionare la cartella WaveDriver98 sul CD Pro Tools LE, quindi
fare clic su OK.

6 Chiudere la finestra di dialogo per l'installazione da disco facendo clic su OK.
7 Nella finestra di dialogo Selezione periferiche scegliere Digidesign Digi 001 e fare clic su OK.

8 Per installare i driver necessari fare clic su Avanti.

A Se viene visualizzato il messaggio "DigiProx: Cannot run with this version of
XXXXX.dII," seguire le istruzioni visualizzate nella finestra di dialogo.

9 Al termine dell'installazione del software richiesto per il nuovo dispositivo, fare clic su Fine.

Aggiornamento delle versioni precedenti dei driver Wave

Se si e gia utilizzata una versione precedente di Pro Tools e si desidera installare una nuova versione
del software Pro Tools LE, i driver wave esistenti verranno aggiornati automaticamente dal
programma di installazione Pro Tools LE.

Capitolo 3: Configurazione dei sistemi Windows
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Installazione del software Pro Tools LE
Dopo aver installato I'nardware Digi 001 e i relativi driver wave, procedere all'installazione di

Pro Tools LE.

Per installare Pro Tools LE in Windows

1 Inserire il CD di installazione di Pro Tools LE nell'unita CD-ROM. Viene visualizzata una schermata
in cui viene mostrato il contenuto del CD-ROM.

2 Aprire la cartella Pro Tools LE Installer, quindi fare doppio clic sul programma di installazione
(Setup).

&

3 All'apertura del programma di installazione, fare clic su Next per proseguire.

4 Scegliere una delle seguenti tre opzioni di installazione:

Typical: & consigliata agli utenti che utilizzano il programma per la prima volta

Compact: scegliendo questa opzione, vengono installati soltanto i componenti necessari
all'esecuzione di Pro Tools LE

e Custom: consente di scegliere i componenti da installare (per utenti esperti)

5 Fare clic su Next per procedere all'installazione dell'opzione selezionata. | file vengono installati
nella cartella Digidesign all'interno della cartella Programmi.

6 Al termine dell’installazione riavviare il sistema.

Installazione della sessione demo

Il sistema Digi 001 comprende due sessioni demo, Pro Tools SoundCheck Digi001.pt5, che puo essere
usata per verificare il corretto funzionamento del sistema e Be There Digi001.pt5, una demo piu
completa che puo essere usata per testare il sistema di riproduzione e per apprendere alcune funzioni
di Pro Tools LE mediante I'esercitazione contenuta nel Capitolo 5, "Utilizzo della sessione demo".

A Prima di installare le sessioni demo nell'unita audio, verificare che I'unita sia configurata
come descritto nella sezione "Requisiti di sistema relativi al disco rigido" a pagina 22.

Per installare le sessioni demo:

1 Inserire il CD di installazione di Pro Tools LE nell'unita CD-ROM. Viene visualizzata una schermata
con il contenuto del CD-ROM.

2 Aprire la cartella Pro Tools Demo Installer, quindi fare doppio clic sul programma di installazione
(Setup).
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3 All'apertura del programma di installazione, fare clic su Browse per definire la cartella di
destinazione sull'unita audio, quindi fare clic su Next.

4 Selezionare i componenti da installare per le sessioni SoundCheck Session e Be There.

5 Fare clic su Next per procedere all'installazione delle sessioni demo.

Rimozione di Pro Tools LE e dei driver wave di Digi 001
Per rimuovere il software Pro Tools LE, utilizzare Installazione applicazioni nel Pannello di controllo.

Spostarsi in Sistema nel Pannello di controllo per rimuovere il driver wave Digi 001.

Per rimuovere Pro Tools LE:

1 Dal menu Start scegliere > Impostazioni > Pannello di controllo.
2 Fare doppio clic sull'icona Installazione applicazioni.
3 Selezionare Pro Tools LE dall'elenco delle applicazioni e fare clic su Aggiungi/Rimuovi.

4 Se durante la rimozione del programma viene richiesto di rimuovere i file condivisi, fare clic su Si
tutti.

5 Selezionare Digidesign System Files dall'elenco dei programmi e fare clic su Aggiungi/Rimuovi.
6 Chiudere Installazione applicazioni e il Pannello di controllo.

7 Riavviare il computer.

Per rimuovere i driver wave Digi 001:

1 Fare clic con il tasto destro del mouse sull'icona Risorse del computer sul desktop, quindi scegliere
Proprieta dal menu a comparsa visualizzato.

2 In alternativa nel Pannello di controllo fare doppio clic su Sistema, quindi fare clic sulla scheda
Gestione periferiche.

3 Individuare e selezionare il dispositivo Digi 001, quindi fare clic su Rimuovi.
4 Quando richiesto, confermare la rimozione del dispositivo.

5 Al termine chiudere il Pannello di controllo.

6 Se si utilizza Windows Explorer, individuare e rimuovere il seguente file:
Windows\Inf\Other\DigidesignDALWDM.inf

7 Riavviare Windows.

Capitolo 3: Configurazione dei sistemi Windows
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Requisiti di sistema relativi al disco rigido

(Windows)

Per la registrazione e la memorizzazione dei file in Windows, Pro Tools LE richiede una o piu unita
approvate ATA/IDE o SCSI con le seguenti caratteristiche:

« Formattazione con file system FAT16 o FAT32 (FAT32 consigliato)

« Velocita di trasmissione dati di 3 MB al secondo o piu veloce

« Velocita di rotazione dell'unita di 7.200 RPM o piu veloce

* Tempo di posizionamento medio di 10,0 millisecondi o piu veloce

Q Per informazioni piu aggiornate sulla compatibilita con il disco rigido e gli adattatori bus
" host (HBA) SCSlI, visitare il sito Web di Digidesign (www.digidesign.com/compato/).

Utilizzo di unita di sistema per la registrazione e la riproduzione audio

Sebbene con Pro Tools sia possibile registrare dall'unita di sistema, solitamente questa procedura non
e consigliata. Le prestazioni per la registrazione e la riproduzione su dischi rigidi di sistema risultano
peggiori rispetto ai dischi rigidi non di sistema, con un numero inferiore di tracce e di plug-in.

Si consiglia di registrare sulle unita di sistema solo quando é assolutamente necessario; ad esempio se
il computer utilizzato € dotato di una sola unita disco rigido o se le altre unita disco rigido non
dispongono di spazio libero.

Dischi rigidi SCSI

Le unita disco rigido SCSI presentano numerosi vantaggi rispetto alle unita ATA/IDE. In primo luogo
le unita SCSI possono essere anche esterne e quindi rappresentano un supporto di memorizzazione
audio portatile che puo essere trasferito facilmente da un sistema all'altro. In secondo luogo
consentono di ottenere prestazioni leggermente migliori per quanto riguarda la registrazione su un
numero elevato di tracce; se si cerca di registrare un numero elevato di tracce con un'unita ATA/IDE,
si verifichera un breve ritardo prima dell'inizio della registrazione.

Formattazione e deframmentazione delle unita

Prima di cominciare & consigliabile ripetere la formattazione dell'unita audio con file system FAT32 al
fine di ottenere prestazioni ottimali. Occorre anche eseguire periodicamente la deframmentazione
dell'unita audio per ottenere prestazioni del sistema costanti.

Q Con l'utilita Convertitore di unita (FAT 32) inclusa in Windows ¢ possibile convertire in
FAT32 le unita disco rigido formattate in FAT16.
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Per formattare un'unita audio:
1 Fare doppio clic su Risorse del computer sul desktop.

2 Fare clic con il tasto destro del mouse sull'unita disco rigido che si desidera utilizzare per l'audio e
scegliere Formatta.

3 Impostare il Tipo di formattazione su Completa e fare clic su Avvia.

4 Seguire le istruzioni visualizzate. Al termine dell'operazione chiudere la finestra Formattazione.

Per deframmentare I'unita audio:
1 Fare doppio clic su Risorse del computer sul desktop.

2 Fare clic con il tasto destro del mouse sull'unita disco rigido utilizzata per I'audio e scegliere
Proprieta dal menu a comparsa.

3 Fare clic sulla scheda Strumenti.
4 Scegliere Esegui Defrag e seguire le istruzioni visualizzate sullo schermo.

5 Al termine della deframmentazione, chiudere la finestra Proprieta.

Spazio di memorizzazione su disco rigido

Tracce audio mono registrate con una risoluzione di 16 bit a 44,1 kHz (qualita audio CD) richiedono
circa 5 MB di spazio su disco rigido al minuto. Le stesse tracce registrate a una risoluzione di 24 bit
richiedono circa 7,5 MB al minuto. Nella tabella seguente vengono elencati i requisiti di spazio su
disco rigido di determinati numeri e lunghezze di traccia. Per la scelta della quantita di spazio
necessaria sull'unita disco rigido, tenere in considerazione i dati riportati nella seguente tabella:

Spazio su disco rigido richiesto per tracce audio

Numero di tracce e lunghezza 16 bita 16 bita 24 bita 24 bita
44,1 kHz 48 kHz 44,1 KHz 48 kHz

1 traccia mono, 1 minuto 5 MB 5,5 MB 7,5 MB 8,2 MB

1 traccia stereo (o due tracce 50 MB 55 MB 75 MB 83 MB

mono), 5 minuti

1 traccia stereo (o due tracce 600 MB 662 MB 900 MB 991 MB

mono), 60 minuti

24 tracce mono, 5 minuti 600 MB 662 MB 900 MB 991 MB

24 tracce mono, 60 minuti 7 GB 7,8 GB 10,5 GB 11,6 GB

Capitolo 3: Configurazione dei sistemi Windows
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Awvio di Pro Tools LE per la prima volta

Immissione del numero di serie

Quando si avvia Pro Tools LE per la prima volta, viene chiesto di immettere il numero di serie.

Please enter the serial number provided with this version of Pro Tools:

[ | (Ccancer] [[varidate ]

Immissione del numero di serie per Pro Tools

Il numero di serie ¢ riportato nella copertina interna della presente guida. Immettere il numero di
serie nella finestra di dialogo, osservandone gli spazi e I'uso delle maiuscole, quindi fare clic su
Validate.
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capitolo 4

Collegamento dell'impianto di registrazione

In questo capitolo viene spiegato come collegare Digi 001 mixer, sistema di amplificazione,
registratori digitali e altri dispositivi dell'impianto di registrazione e come collegare le sorgenti audio
per la registrazione.

Ingressi e uscite del dispositivo I/0 Digi 001

Tutti gli ingressi e le uscite di Digi 001 sono calibrati in fabbrica su un margine di sicurezza di 14 dB
al di sotto di 0 dB o sul valore massimo. Cio significa che al livello di ingresso di riferimento nominale
(+4 dBu o -10 dBV) si puo disporre di un massimo di 14 dB come margine di sicurezza prima del
clipping in ingresso o in uscita.

Connettori nel pannello anteriore del dispositivo 170 Digi 001

ingresso alimentazione ingresso interruttore per  guadagno
mic/line 1 con Phantom 48V mic/line 2 con modalita di in cuffia
preamplificatore preamplificatore  monitoraggio |

digiddsign

1 —4 2
BPlo, Xp® 8%, 00Q

1 1 T
pulsante -26 dB | indicatore guadagno indicatore
guadagnoin alimentazione in ingresso accensione
ingresso Phantom

pulsante -26 dB  volume di monitoraggio uscita cuffia

Ingressi mic/line 1 e 2

Questi ingressi bilanciati o non bilanciati sono progettati per ingressi di microfoni o a livello di linea (con
pad da -26 dB). Sono compatibili con connettori XLR o da 1/4 di pollice per ingressi audio analogici.

Pulsanti 1 e 2 -26 dB

Questi interruttori consentono di adattare i segnali di livello di linea sugli ingressi mic/line 1 e 2
riducendo la sensibilita in ingresso di -26 dB.
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Guadagno iningresso 1 e 2

Questi controlli consentono di regolare il guadagno negli ingressi mic/line 1 e 2.

Alimentazione Phantom

Questo interruttore consente di applicare I'alimentazione phantom da 48V agli ingressi mic/line 1 e
2. Questi ingressi forniscono alimentazione phantom da 48V ai microfoni che la richiedono.

Microfoni dinamici (ad esempio Shure SM57) non richiedono l'alimentazione phantom per
funzionare, ma non ne vengono danneggiati. La maggior parte dei microfoni a condensatore (ad
esempio AKG C300) richiede I'alimentazione phantom. In caso di dubbi sul tipo di alimentazione
richiesta dal proprio microfono, si consiglia di contattare il produttore o di leggere la
documentazione fornita con il microfono.

A Nonostante I'alimentazione phantom possa essere usata con la maggior parte dei
microfoni, pud tuttavia danneggiare i microfoni a nastro. Spegnere sempre
I'alimentazione phantom e aspettare che la spia rossa dell'alimentazione si spenga
completamente prima di connettere o disconnettere un microfono a nastro.

Spia di alimentazione Phantom

Quando e acceso (rosso), questo LED indica che I'alimentazione ¢ attiva.

Pulsante Monitor Mode

Quando questo pulsante € premuto, nel dispositivo I/0 Digi 001 viene attivata la funzione Monitor
Mode (modalita di monitoraggio) che consente di monitorare gli ingressi analogici 3 e 4 sul dispositivo
1/0 Digi 001 anche quando il computer € spento. Utilizzare questa modalita per monitorare un
dispositivo audio, come ad esempio un lettore CD o un sintetizzatore, senza accendere il computer.

Volume di monitoraggio

Questo controllo consente di regolare il livello del segnale in uscita per le uscite di monitoraggio
destra e sinistra. Consente anche di regolare il livello di queste uscite quando il dispositivo I/O si trova
in modalita di monitoraggio. Le uscite di monitoraggio riflettono anche l'audio indirizzato alle uscite
1 e 2 nel software e sul dispositivo 1/0.

Spia di accensione

Quando ¢ acceso (verde), questo LED indica che il dispositivo 1/0 Digi 001 € acceso. Il computer deve
essere acceso per alimentare I'unita Digi 001.

Guadagno cuffie

Questo controllo consente di regolare il livello di uscita del connettore della cuffia.
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Uscita cuffie

Utilizzare l'uscita cuffie per collegare le cuffie stereo. Questo connettore puo essere utilizzato con uno
spinotto stereo da 1/4 di pollice. Da questa uscita viene riprodotto qualsiasi segnale audio indirizzato
alle uscite analogiche 1 e 2 in Pro Tools LE. L'uscita cuffie viene disabilitata se la modalita di

monitoraggio non é attiva (per ulteriori informazioni vedere "Pulsante Monitor Mode" a pagina 26).

Connettori sul pannello posteriore del dispositivo I/0 Digi 001

I/0digitale  numero connettore uscite di
S/PDIF seriale footswitch monitoraggio

|
O ‘
L

P 60 00000
|

[ L |
MIDI MIDI  connettore ingressi 3-8 uscite 1-8
in out del computer analogici analogiche

Ingresso/uscita digitali S/PDIF

Il formato Sony Phillips Digital Interface (S/PDIF) é utilizzato in molti lettori CD e registratori DAT per uso
professionale e domestico. | connettori di ingresso/uscita S/PDIF sono prese fono (RCA) a due conduttori
non bilanciate che utilizzano un flusso di dati digitali a 24 bit, a due canali. Per evitare interferenze RF,

utilizzare un cavo coassiale da 75 ohm per trasmissioni S/PDIF che non superi la lunghezza di 10 metri.

Ingresso/uscita MIDI

I connettori MIDI nel dispositivo 1/0 Digi 001 consentono a Digi 001 di fungere da interfaccia MIDI.
Un driver MIDI per questo dispositivo viene installato quando si installa Pro Tools LE ed &
riconosciuto da Windows Multimedia oppure quando si aggiornano le schede e le interfacce MIDI in
OMS Setup (Macintosh). Un ingresso e un'uscita MIDI consentono di inviare e ricevere MIDI su 16
canali. Con questi connettori € possibile utilizzare cavi MIDI a 5-pin standard. Ingressi/uscite MIDI
Digi 001 possono essere usati oltre alle interfacce MIDI gia in uso.

Connettore del computer

Questo connettore & utilizzato per collegare il dispositivo I/0 alla scheda PCI Digi 001. Il cavo per
eseguire questa connessione ¢ fornito in dotazione con il sistema.

Connettore per footswitch

Questo connettore consente di collegare un footswitch che puo essere utilizzato per controllare il
punch-in e punch-out audio QuickPunch e per le funzioni di registrazione punch-in e punch-out
MIDI. Sono supportate le modalita di registrazione a pedali continuous on/continuous off e
instantaneous on/off con connettore TRS da 1/4 di pollice. Per ulteriori informazioni vedere la
sezione "Registrazione mediante footswitch" a pagina 72.
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Ingressi di monitoraggio (ingressi analogici 3 e 4)

Questi connettori sono utilizzati per collegare le sorgenti audio analogiche 3 e 4 o sorgenti stereo,
quali un lettore CD, un sintetizzatore o un deck per cassette per il monitoraggio quando si utilizza il
dispositivo I/0 Digi 001 in modalita di monitoraggio. In modalita di monitoraggio il segnale
proveniente dall'ingresso 3 € indirizzato verso l'uscita sinistra e il segnale proveniente dall'ingresso 4
verso l'uscita destra. Si tratta di connettori bilanciati da 1/4 di pollice.

Ingressi analogici 3-8

Questi ingressi sono utilizzati per collegare sorgenti audio analogiche indirizzate agli ingressi
analogici 3-8. Sono connettori TRS bilanciati da 1/4 di pollice per ingressi audio analogici. Questi
ingressi analogici dispongono di convertitori analogico-digitale a 24 bit.

Uscite di monitoraggio

Queste uscite possono essere collegate ad altoparlanti alimentati, a un amplificatore stereo di potenza
oppure a un'altra destinazione stereo per il monitoraggio del missaggio. Dalle uscite di monitoraggio
viene riprodotto il segnale audio indirizzato alle uscite analogiche 1 e 2. L'audio proveniente
dall'uscita analogica 1 viene indirizzato all'uscita di monitoraggio sinistra e l'audio proveniente
dall'uscita analogica 2 viene indirizzato all'uscita di monitoraggio destra. Questi ingressi analogici
dispongono di convertitori digitale-analogico a 24 bit. E possibile controllare il livello del segnale in
uscita per le uscite di monitoraggio tramite il controllo del volume di monitoraggio. Si tratta di
connettori bilanciati da 1/4 di pollice.

Uscite analogiche principali 1 e 2

Da queste uscite principali viene riprodotto il segnale audio indirizzato alle uscite analogiche 1 e 2. Da
queste uscite provengono i segnali dell'uscita destra e sinistra indirizzati a un deck a nastro per
missaggi oppure a un'altra destinazione stereo. Queste uscite analogiche dispongono di convertitori
digitale-analogici a 24 bit. Si tratta di uscite bilanciate con livello di linea +4 dBu. | connettori sono
da 1/4 di pollice.

Uscite analogiche 3-8

Da queste uscite viene riprodotto il segnale audio indirizzato alle uscite analogiche 3-8. Queste uscite
analogiche dispongono di convertitori digitale-analogico a 24 bit, non sono bilanciate e dispongono
di un livello di linea pari a -10 dBu. | connettori sono da 1/4 di pollice.
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Connettori sulla scheda PCI Digi 001

La scheda PCI Digi 001 deve essere installata in uno slot PCI libero del computer. La scheda PCI
comprende I/O ottici e digitali per otto canali ADAT I/O oppure due canali S/PDIF I/0O e un connettore
per il dispositivo I/0 Digi 001.

Connettore
dispositivo I/0 —— I

Ingresso ottico

Uscita ottica
(la luce rossa

identifica I'uscita) c ttore PCI
onnettore

Ingresso ottico

L'ingresso ottico € collegato a una sorgente audio ottica o una sorgente ottico-digitale che puo essere
una sorgente audio ADAT a otto canali o una sorgente audio S/PDIF a due canali. Il formato digitale
accettato da questo ingresso € commutabile in Pro Tools LE. Questo collegamento fornisce un segnale
audio digitale massimo di 24 bit per entrambi i formati. Questo formato utilizza un cavo ottico
"lightpipe" standard. Un cavo ottico viene fornito in dotazione con l'unita Digi 001.

Uscita ottica

L'uscita ottica consente di inviare il segnale audio ottico-digitale a destinazioni quali, un mixer
digitale o un registratore digitale. Tale destinazione puo presentare un formato ADAT a otto canali o
S/PDIF audio a due canali. Il formato di uscita digitale ¢ commutabile in Pro Tools LE. Questo
collegamento fornisce un segnale audio digitale massimo di 24 bit per entrambi i formati. Questo
formato utilizza un cavo ottico "lightpipe" standard. Con Digi 001 & incluso un cavo ottico.

Connessioni di segnale con Digi 001

Digi 001 puo essere utilizzato con numerose configurazioni audio, comprese:
< mixer, amplificatore di potenza e altoparlanti

* un mixer e una coppia di altoparlanti amplificati e autoalimentati

« un ricevitore e altoparlanti stereo

e una coppia di altoparlanti amplificati e autoalimentati

Capitolo 4: Collegamento dell'impianto di registrazione
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Monitoraggio audio

Il volume di monitoraggio degli altoparlanti collegati alle uscite di monitoraggio & controllato
mediante la manopola del volume di monitoraggio (vedere "Volume di monitoraggio" a pagina 26 per
ulteriori informazioni). Il volume delle cuffie & controllato mediante la manopola di guadagno cuffie
(vedere "Guadagno cuffie" a pagina 26 per ulteriori informazioni).

Per collegare le cuffie:

1 Collegare le cuffie al connettore delle cuffie sul dispositivo I/0. Con questo ingresso cuffie &
possibile utilizzare uno spinotto stereo da 1/4 di pollice. Se le cuffie sono dotate di uno spinotto piu
piccolo, si consiglia di acquistare un adattatore dal rivenditore di zona. Per ottenere risultati ottimali,
utilizzare cuffie chiuse di alta qualita.

volume di ingresso
monitoraggio cuffile

digidesign

05, Qo0 e, 0

2608 Gain 48V On WiciLine 2608 Gain _ Monitor Mode Gain Power _Headphone

1
guadagno cuffie

2 Regolare il volume della cuffie mediante la manopola di guadagno cuffie.

A L'uscita cuffie di Digi 001 consente di riprodurre livelli in uscita molto elevati. L'esposizione
prolungata pud causare danni all'udito. Regolare il volume della cuffia con cautela.
Per collegare un impianto stereo domestico:

1 Collegare i cavi da 1/4 di pollice alle uscite di monitoraggio sul retro del dispositivo I/0 Digi 001.

uscite di monitoraggio

00000
00O

wonour & b

2 Collegare le uscite a una coppia di ingressi destro e sinistro disponibile sul proprio impianto stereo.

Q | sistemi stereo domestici utilizzano spesso connettori RCA. E possibile utilizzare un
adattatore o un cavo speciale per eseguire una conversione dai connettori da 1/4 di pollice
utilizzati da Digi 001 ai connettori RCA del proprio stereo.

Per collegare altoparlanti monitor a un amplificatore di potenza o altoparlanti monitor autoalimentati:

1 Collegare i cavi da 1/4 di pollice alle uscite di monitoraggio sul retro del dispositivo I/0 Digi 001.

2 Collegare le uscite di Digi 001 agli ingressi dell'amplificatore di potenza destro e sinistro oppure agli
altoparlanti autoalimentati destro e sinistro.
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Collegamento di un registratore per missaggi finali

Una volta eseguita la registrazione e il missaggio delle sessioni mediante Digi 001, é possibile che si
desideri eseguire il missaggio finale per DAT, registratore per cassette o altro dispositivo di
registrazione stereo a due tracce.

Collegamento di un deck analogico

Collegare il registratore (deck per cassette o altro dispositivo analogico) alle uscite principali sul retro
del dispositivo I/0 Digi 001. L/1 viene collegato con l'uscita sinistra del registratore ed R/2 viene
collegato all'uscita destra. Si tratta di uscite da 1/4 di pollice. Se gli ingressi del deck di missaggio sono
di tipo RCA, potrebbero essere necessari dei cavi.

uscite principale
destra elsinistra

(=)

conpuTER

i p—
o [—1

Collegamento di un deck digitale

Se si dispone di un'unita DAT o di un altro dispositivo digitale che accetta dati audio digitali S/PDIF
in ingresso o in uscita, collegarlo ai connettori S/PDIF In e S/PDIF Out RCA sul lato posteriore del
dispositivo 1/0 Digi 001.

9000©

ingresso S/PDIF In
uscita S/PDIF Out —

Collegamento di registratori Tascam DA30 DAT
Se si collega un registratore Tascam DA30 DAT, occorrera impostare il formato S/PDIF 1/0O in

Pro Tools LE.

Per impostare il formato S/PDIF I/0 in Pro Tools LE:

1 Awvviare Pro Tools LE e selezionare Setups > Hardware.
2 Fare clic su Other Options e impostare S/PDIF 1/0 a DA30. Fare clic su Done.

3 Fare clic su OK per chiudere la finestra di dialogo Hardware Setup.
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Collegamento delle sorgenti audio all'unita Digi 001

E possibile utilizzare sorgenti audio di due tipi con Digi 001: analogiche o digitali.

Audio analogico

I segnali audio analogici sono riprodotti da microfoni, sintetizzatori, mixer e strumenti con pickup

magnetici. Tra queste sorgenti, i microfoni e gli strumenti a pickup magnetico riproducono i segnali
piu bassi e in genere richiedono maggiore amplificazione. Digi 001 comprende i preamplificatori per
queste sorgenti sugli ingressi mic/line 1 e 2 e I'alimentazione phantom da 48V per entrambi i canali.
Con gli ingressi mic/line 1 e 2 € possibile utilizzare i connettori XLR o da 1/4 di pollice.

guadagno in entrata

digidesign
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Ingresso preamplificatore analogico

Tastiere, preamplificatori e mixer consentono di riprodurre segnali audio a livello di linea che variano
per ciascun dispositivo tra i valori standard di -10 e +4. Per questi dispositivi occorre utilizzare gli
ingressi 3-8 a livello di linea di Digi 001 (sul lato posteriore del dispositivo 1/0 Digi 001). Digi 001
comprende un guadagno software controllabile in grado di accettare i diversi livelli di linea che
possono essere prodotti da questi dispositivi. Con gli ingressi 3-8 & possibile utilizzare connettori da
1/4 di pollice. E anche possibile collegare i segnali di livelli di linea agli ingressi mic/line 1 e 2 sulla
parte anteriore premendo il pulsante -26 dB.

Audio digitale

L'audio digitale rappresenta forme d'onda analogiche contenenti migliaia di campioni digitali al
secondo delle forme d'onda analogiche. Tutti i segnali audio su disco rigido in una sessione
Pro Tools LE sono digitali.

Digi 001 fornisce ingressi digitali per i formati audio digitali ADAT e S/PDIF.

Formato ADAT

Il formato ADAT ¢ stato sviluppato da Alesis per essere utilizzato nei registratori multitraccia ADAT.
Ciascun collegamento ottico ADAT fornisce segnali audio digitali a 8 canali con funzionalita a 24 bit.
E possibile collegare un ADAT o un altro dispositivo ottico di formato ADAT direttamente all' 1/0
ottico sulla scheda PCI Digi 001. Con i connettori ottici 1/0 & possibile utilizzare cavi ottici.
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S/PDIF

Il formato di ingresso e uscita S/PDIF (Sony/Phillips Digital Interchange) é disponibile per numerosi
deck DAT, lettori CD e altri dispositivi digitali. Ciascun collegamento ottico S/PDIF fornisce segnali
audio digitali a 2 canali con funzionalita a 24 bit. L'ingresso digitale S/PDIF puo essere collegato sia a
connettori ottici (vedere Figura 1), sia a connettori S/PDIF RCA sul retro del dispositivo 1/0 Digi 001.
Con i connettori ottici occorre utilizzare cavi ottici; con i connettori RCA cavi RCA.

notare luce
rossa luminosa

Figural. 1/0 ottico sulla scheda PCI Digi 001
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1

ingresso
!
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A Puo essere usata una coppia di ingressi S/PDIF alla volta. Per esempio, se si utilizza
I"ingresso ottico per dati S/PDIF, non ¢ possibile utilizzare gli ingressi RCA.

Mirroring S/PDIF

In Pro Tools LE viene utilizzata la funzione mirroring S/PDIF per riflettere automaticamente l'audio
inviato agli ingressi 1 e 2 sulle uscite S/PDIF RCA. Si tratta di una funzione utile se si esegue il
monitoraggio di un missaggio utilizzando le uscite audio e se si registra la stessa sorgente con un
dispositivo S/PDIF esterno.

E possibile disattivare la funzione mirroring S/PDIF. Questa operazione pud essere utile nel caso in cui
si desideri utilizzare le uscite S/PDIF per inviare un segnale separato a un'unita digitale per effetti
esterna oppure quando si desidera inviare solo alcuni segnali in uscita al dispositivo digitale. Se si
disattiva la funzione mirroring S/PDIF ¢ possibile selezionare le uscite S/PDIF separatamente e

indirizzare le tracce o inviarle a tali uscite.

Per attivare o disattivare la funzione mirroring S/PDIF:

1 Scegliere Setups > Playback Engine.

2 Fare clic su Other Options.

3 Selezionare o deselezionare I'opzione Enable S/PDIF Mirroring.
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Collegamento delle sorgenti audio

Per collegare una sorgente audio analogica:

» Collegare un microfono direttamente all'ingresso mic/line 1 o 2 sulla parte anteriore del dispositivo
1/0 Digi 001. Con questi ingressi € possibile utilizzare connettori XLR o TRS da 1/4 di pollice. Se il

microfono richiede I'alimentazione phantom, premere l'interruttore dell'alimentazione Phantom
(con la dicitura 48V).

A L'alimentazione phantom puo essere utilizzata con la maggior parte dei microfoni, ma
pud danneggiare i microfoni a nastro. Spegnere sempre I'alimentazione phantom e

aspettare che la spia rossa si spenga completamente prima di collegare o scollegare un
microfono a nastro.

= Collegare le sorgenti di livello di linea (sintetizzatori, segnali in uscita del mixer, microfoni o

chitarre amplificate mediante un preamplificatore esterno) agli ingressi analogici sul lato posteriore
del dispositivo 1/0 Digi 001.
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Collegamento di diversi microfoni a un sistema Digi 001

34 Guida introduttiva a Digi 001



SERAL WONTOR NPUTL

WONTOR IpUT

mm-m

mm S

Wur 5

WeuTs

OrQ00o0O

weurs wollors b ourrurrel outeurs  outeuTs  outrurs

W

ingressi 3-4
analogici

uscita audio destra e sinistra

uscita di monitoraggio destra e sinistra

altoparlanti di
monitoraggio alimentati

Collegamento di un sintetizzatore a un‘unita Digi 001
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Per collegare una sorgente audio digitale:

1 Collegare un dispositivo ottico di formato ADAT o S/PDIF all'ingresso ottico sulla scheda PCI
Digi 001 oppure collegare un dispositivo RCA S/PDIF ai connettori RCA sul retro del dispositivo 1/0
Digi 001.

A E possibile utilizzare soltanto una coppia di ingressi S/PDIF (RCA o ottici) alla volta.

A L'operazione seguente deve essere eseguita solo se il dispositivo richiede Pro Tools LE per
la sincronizzazione. (Nella maggior parte dei casi é preferibile sincronizzare un
dispositivo con Pro Tools LE.) Cid potrebbe essere necessario se si registra da un
dispositivo ottico o S/PDIF. Per ulteriori informazioni leggere la documentazione relativa
al dispositivo.

2 In Pro Tools LE selezionare una modalita Sync. Scegliere Setups > Playback Engine e selezionare
Optical o S/PDIF (RCA), in base a dove é stato collegato il dispositivo digitale.

3 Se si utilizza I'ingresso ottico della scheda PCI Digi 001, fare clic su Other Options e selezionare il
formato di ingresso ottico (ADAT o S/PDIF).

Finestra di dialogo Hardware Setup selezionare qui la modalita Sync (vedere selezionare qui il formato

I"avvertimento prima di procedere al punto 2)  di ingresso ottico
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Schemi di configurazione per studi di registrazione

Lo studio di registrazione effettivamente utilizzato differira in base ai sistemi utilizzati. Le figure
seguenti mostrano due tipi di studi di registrazione domestici.
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Configurazione dello studio di registrazione Digi 001 con un mixer
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Configurazione dello studio di registrazione Digi 001 senza mixer
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Collegamento di un dispositivo ADAT a Digi 001

Se si utilizza un dispositivo ADAT o un altro dispositivo ottico di formato ADAT con l'unita Digi 001,
¢ possibile collegarlo alle porte ottiche della scheda PCI Digi 001. E inoltre possibile collegare a questa
porta un dispositivo S/PDIF dotato di collegamenti ottici.

Una volta installato, configurato e avviato Pro Tools LE, seguire queste istruzioni per collegare un

dispositivo ADAT.

Per collegare un dispositivo ADAT a Digi 001:

1 Collegare l'uscita ottica del dispositivo ADAT alla porta Optical In della scheda PCI Digi 001.

2 Collegare I'ingresso ottico del dispositivo ADAT alla porta Optical Out della scheda PCI Digi 001.
Quando l'unita Digi 001 é accesa, viene emessa una luce rossa dalla porta Optical Out.

scheda PCI Digi 001

La luce rossa indica I'uscita ottica

3 In Pro Tools LE scegliere Setups > Playback Engine e selezionare Optical dal menu a comparsa Sync

Mode.

4 Fare clic su Other Options e selezionare ADAT dal menu a comparsa Input Format.

Capitolo 4: Collegamento dell'impianto di registrazione

39



Utilizzo della funzione Monitor Mode

La funzione Monitor Mode (modalita di monitoraggio) consente di monitorare gli ingressi analogici
3-4 del dispositivo 1/0 Digi 001 anche quando il computer € spento o il dispositivo 1/0 Digi 001 non
¢ collegato al computer. E possibile utilizzare questa funzione per monitorare un lettore CD, un
sintetizzatore o un dispositivo a nastro senza mixer esterno e con il computer spento.

Per utilizzare la funzione Monitor Mode:

1 Collegare le uscite audio analogiche del proprio dispositivo alle entrate analogiche 3 e 4 sul retro del
dispositivo 1/0 Digi 001.

2 Collegare gli altoparlanti per il monitoraggio audio alle uscite di monitoraggio sul retro del
dispositivo 1/0 Digi 001 (vedere "Monitoraggio audio" a pagina 30 per ulteriori informazioni sul
collegamento).

3 Premere il pulsante Monitor Mode.

4 Regolare il volume di monitoraggio mediante la manopola apposita.

utilizzo della manopola del volume di
monitoraggio per il controllo del volume
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Utilizzo della funzione Monitor Mode
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Collegamenti MIDI

Se si utilizzano le porte MIDI integrate dell'unita Digi 001 oppure un'interfaccia MIDI esterna, un
controller di tastiera MIDI e strumenti MIDI, & possibile sfruttare al massimo le funzionalita MIDI di
Pro Tools LE. Queste comprendono la registrazione e il montaggio delle tracce MIDI, la
sincronizzazione con il time code MIDI oppure il Beat Clock MIDI (questo richiede un'interfaccia
MIDI appropriata) e l'utilizzo di una superficie di controllo MIDI.

Per collegare dispositivi MIDI:

1 Quando si utilizzano cavi MIDI a 5 pin, occorre collegare I'uscita MIDI Out del dispositivo o
controller MIDI all'ingresso MIDI In del dispositivo I/0 Digi 001.

2 Collegare I'ingresso MIDI In del dispositivo o controller MIDI all'uscita MIDI Out del dispositivo 1/0
Digi 001.

3 Collegare le uscite audio del proprio dispositivo agli ingressi audio del dispositivo I/0 Digi 001 (o
a un mixer esterno, se in uso).

Per ulteriori informazioni sulla configurazione di OMS (Open Music System) per I'utilizzo
di Pro Tools LE nei sistemi Macintosh, vedere "Installazione e configurazione di OMS" a
pagina 9.

Per informazioni sulla configurazione di una superficie di controllo MIDI da utilizzare
con Pro Tools LE, consultare il manuale online MIDI Control Surfaces Guide.

Utilizzo di dispositivi per effetti esterni

L'unita Digi 001 puo essere collegata a dispositivi analogici dedicati digitali esterni. E possibile inviare
e ricevere segnali da dispositivi analogici mediante ingressi e uscite analogici del dispositivo I/0
Digi 001. E inoltre possibile inviare e ricevere segnali digitali da un dispositivo esterno che supporti
I'ingresso/uscita digitali (per esempio un'unita di riverbero) ed eseguire il monitoraggio mediante le
uscite analogiche oppure (se inutilizzata) I'altra uscita digitale.

Se si desidera utilizzare gli ingressi e le uscite digitali nel sistema Pro Tools LE come mandate e ritorni
di effetti verso un dispositivo per effetti digitale, nella maggior parte dei casi Pro Tools LE dovrebbe
essere il master clock. Impostare il dispositivo per effetti digitale in modo che accetti un clock digitale
esterno, in modo che venga sincronizzato con Pro Tools LE.
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Per collegare un dispositivo esterno digitale al sistema:

1 Collegare l'uscita (o le uscite in un dispositivo stereo) non utilizzata del dispositivo I/0 Digi 001 a
un ingresso (o ingressi in un dispositivo stereo) del processore di segnali esterno.

2 Collegare l'uscita (o le uscite in un dispositivo stereo) del processore di segnali esterno a un ingresso
(o una coppia di ingressi in un dispositivo stereo) non utilizzato sul dispositivo I/0 Digi 001.

Per impostare una mandata verso un dispositivo digitale esterno (solo mandate/ritorni digitali):
1 Scegliere Setups > Playback Engine e fare clic su Other Options.

2 Eseguire una delle operazioni seguenti:

« Se il dispositivo esterno é collegato ai connettori S/PDIF RCA, disattivare la funzione mirroring
S/PDIF. (Quando la funzione mirroring S/PDIF & attivata, l'uscita digitale in corrispondenza dei
connettori S/PDIF RCA riflette esattamente I'uscita dei canali analogici 1-2.) Se si disattiva la
funzione mirroring S/PDIF, occorre riconfigurare 1/0 Setup per riflettere questa modifica.
Consultare la Guida di riferimento di Pro Tools per informazioni dettagliate su tale utilizzo della
finestra di dialogo 1/0 Setup.

« Seil dispositivo esterno e collegato a porte ottiche, scegliere un formato (probabilmente S/PDIF per
un dispositivo per effetti) dal menu a comparsa Optical Format.

3 Scegliere Internal dal menu a comparsa Sync Mode (nella maggior parte dei casi).

4 Fare clic su OK.

E possibile utilizzare la finestra di dialogo 1/0 Setup (Setups > 1/O Setup) per
contrassegnare gli ingressi e le uscite in uso in Pro Tools LE e per identificarle come insert
0 mandate quando si lavora a una sessione. Per ulteriori informazioni consultare la
Guida di riferimento di Pro Tools.
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Utilizzo della sessione demo

Riproduzione della sessione demo

Questa sezione illustra la procedura di apertura e riproduzione di una sessione demo. Per apprendere
le nozioni fondamentali sul missaggio e I'editing con Pro Tools LE, € anche possibile utilizzare
I'esercitazione inclusa.

Definizione di sessione

Una sessione consiste in un documento Pro Tools LE contenente tutte le istruzioni per il missaggio e
I'editing, nonché le istruzioni MIDI di un brano musicale. Una trattazione approfondita dei file di
sessione e contenuta nella Guida di riferimento di Pro Tools.

Esecuzione dell’applicazione in sistemi Macintosh piu vecchi

Le elaborazioni audio di Pro Tools LE vengono eseguite dal processore del computer e tale
elaborazione assorbe molte risorse di sistema, pertanto puo risultare eccessiva per i sistemi pit vecchi,
quali ad esempio i modelli Macintosh anteriori al Power G3. Per ottenere migliori risultati nell'utilizzo
di Pro Tools LE con vecchi sistemi, si consiglia di seguire le seguenti istruzioni.
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Per configurare Pro Tools LE in un sistema Macintosh precedente al modello G3:

1 Eseguire il software Pro Tools LE facendo doppio clic sulla relativa icona all'interno della cartella
Pro Tools contenuta nella cartella Digidesign.

2 Impostare la dimensione massima del buffer hardware. Per eseguire questa operazione scegliere
Setups > Hardware, quindi impostare la dimensione del Buffer H/W su 1024 Samples dal relativo

menu a comparsa.

3 Impostare il valore massimo della percentuale di utilizzo della CPU (CPU Usage Limit), scegliendo
85% dal relativo menu a comparsa nella finestra di dialogo Hardware Setup. Fare clic su OK.

Hischaiis Schiy

| et e 1 plecris:
———
S ke

L T T
CPU U g Linst: | 45 % I

Lk Uphan: |

impostare su 1024 Samples

impostare su 85%

Finestra di dialogo Hardware Setup contenente le impostazioni per sistemi Macintosh piu lenti
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Esecuzione dell'applicazione in sistemi Windows piu lenti

Le elaborazioni audio di Pro Tools LE vengono eseguite dal processore del computer. Nonostante la
maggior parte dei PC Windows dovrebbe disporre di una potenza di calcolo sufficiente per
I'esecuzione di Pro Tools LE, potrebbero verificarsi problemi durante I'esecuzione del software in
computer piu lenti. Per ottenere prestazioni migliori durante I'utilizzo di Pro Tools LE con vecchi
sistemi, si consiglia di seguire le seguenti istruzioni.

1 Awvviare Pro Tools LE scegliendo Start >Programmi> Digidesign > Pro Tools > Pro Tools LE.

@ | Startl

5 Fro Tools » @ Documentation ¥
T DigiTest
C I Fro Tools® LE

Awio di Pro Tools LE in Windows

2 Impostare la dimensione massima del buffer hardware. Per eseguire questa operazione scegliere
Setups > Hardware, quindi impostare la dimensione del Buffer H/W su 512 o 1024 Samples dal
corrispondente menu a comparsa.

128 Samples
286 Samples

5 SmplES —— Impostare la dimensione del buffer su questo
1024 Samples intervallo di valori per PC Windows pitl lenti

Impostazioni buffer per PC Windows piu lenti

3 Impostare il valore massimo della percentuale di utilizzo della CPU (CPU Usage Limit) su 85% dal
relativo menu a comparsa nella finestra di dialogo Hardware Setup.
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Struttura di una sessione demo

Questa sezione demo Pro Tools LE contiene due diversi mix del brano "Be There". Il primo € una
dimostrazione delle funzionalita e dell'elevata qualita audio di Pro Tools LE. Il secondo offre un
percorso esemplificativo delle funzionalita del software descritte in questa guida. Se si desidera
avviare questa esercitazione, consultare "Esercitazione per il missaggio in una sessione demo" a
pagina 48.

Riproduzione della sessione demo

Per riprodurre una sessione demo:

1 Individuare la sessione demo sull'unita audio su cui € stata installata. All'interno dell'unita aprire la
cartella Pro Tools LE Demo Sessions. Quindi aprire la cartella "Be There" Demo Session (Macintosh) o Be
There Demo Session (Windows).

2 Fare doppio clic sul file della sessione, Be There Digi001 (Macintosh) o Be There Digi001.pt5
(Windows) per aprirla (se Pro Tools LE non ¢ in esecuzione, verra avviato automaticamente).

Macintosh Windows

contiene i file audio della sessione

] =—={]] “Be There” Demo Session———=HH
4items, 18.01 GE available

Be Thers Digi001  Be Thers ToolBox  Audio Files Be There SampleCel|

-

. doo - sl
sessione demo  contieneifile  contiene strumenti
(fare doppio clic audio della e campioni per |
per aprire) sessione utenti SampleCell . . i L
sessione demo contiene strumenti e campioni
(fare doppio clic per aprire) per utenti SampleCell
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All'apertura il file di "Be There" appare come nella seguente illustrazione:

Finestra — g BeThera FI—o—oUH
Mix [ e
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Drurn Sub
loopl
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LoopSterea
Tamb
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bgrrxa
bgwx5
Virusbrpg.
Wirus P 1
Slap Rin
Master 1
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MaracasSt
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B Yo
gl vae

Gruppi ——=1220

| srref Ko ars oo | e e e Umm |/—|j| Finestra

—— Transport
Tracce Contatore
Finestre Mix, Memory Locations e Transport della sessione demo di Be There

3 Assicurarsi che il pulsante Monitor Mode sia spento (non attivato).

MiciLine 2608 Gain a8V

digidesign

Gain

2
]

2648

|
Pulsante Monitor Mode
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4 Fare clic sulla prima posizione di memoria "Play the Song" nella finestra Memory Locations. Questa
posizione di memoria corrisponde all'inizio del brano musicale. Se la finestra Memory Locations non
é visualizzata, scegliere Windows > Show Memory Locations.

Posizioni di memoria
(selezionarne una  —
facendovi clic sopra)

Finestra Memory Locations

5 Fare clic su Play nella finestra Transport. Se la finestra Transport non & visualizzata, scegliere
Windows > Show Transport.

Indietro veloce  Riproduci Vai alla fine Contatore
15} u ] |
‘ Stop ‘ Registra
Torna allo zero Avanti veloce

Finestra Transport

6 A questo punto dovrebbe avviarsi la riproduzione del brano. Fare clic su Stop per interromperla.

Esercitazione per il missaggio in una sessione demo

Prima di partire con il missaggio audio in Pro Tools LE, € opportuno leggere la risposta a una
domanda ricorrente:

E possibile rovinare una registrazione?

Quando si esegue il montaggio e il missaggio audio in una sessione, i file audio sottostanti non
vengono modificati. Pertanto anche se si eseguono piu sessioni utilizzando gli stessi file audio con
mix e arrangiamenti diversi, i file audio utilizzati restano immutati all'interno della cartella Audio
Files della sessione. Quando si modifica un missaggio o si salva una sessione diversa, non c'¢ il rischio
di perdere preziose registrazioni, pertanto si ¢ liberi di provare idee e arrangiamenti diversi.
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Superficie di lavoro Pro Tools LE

Pro Tools LE contiene due finestre principali per la visualizzazione delle tracce: la finestra Mix e la
finestra Edit. Si prendera prima in esame la finestra di missaggio e successivamente quella di
montaggio.

La finestra Mix presenta l'aspetto e le funzionalita di una console di missaggio automatica dove
ciascuna traccia e visualizzata come una fila di canali contenente controlli specifici per volume, pan,
modalita di automazione, insert e mandate, registrazione e cosi via.

* Wi L |
Ingresso —I—_' e 2
Ay 1
. Ay
Uscita = A
b
dadog T
Volume ;
gl |
Pan gl
gl
- Dl
Modalita di — pical &
automazione st
Registra wu = I;
Solo Pulsante Mute m:
Dispositivo di
scorrimento Pan
Attiva gruppi Apre finestra Output
Indicatore di clipping
(luci rosse quando € in
Fader del corso il clipping)
volume

- Meter di livello (stereo)

Nome traccia

Fila di canali nella finestra Mix con relativi menu a comparsa
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Per visualizzare la finestra Mix:

= Scegliere Windows > Show Mix.

Durante lI'impostazione della sessione demo viene attivata I'opzione Narrow Mix Window che
consente di visualizzare un maggiore numero di tracce all'interno della finestra Mix riducendo le
dimensioni delle file di canali.

Per ridimensionare I'ampiezza della finestra Mix da normale a ridotta:

» Selezionare o deselezionare I'opzione Display >Narrow Mix Window.

Awvio del missaggio

Dopo avere compreso alcuni degli elementi principali della finestra Mix, si pud passare al missaggio
della sessione demo.

Regolazione del volume di una traccia

Occorre prima regolare il volume della traccia "loopl". Fare clic sulla posizione di memoria "Loop 1
Vol + Pan" nella finestra Memory Locations. Tale finestra, raffigurata nell'immagine sottostante,
consente di spostarsi tra le posizioni di memoria di una sessione.

Eseguire la riproduzione della sessione visualizzando la finestra Mix, quindi variare il volume della
traccia "loopl1" e ascoltare le differenze nel missaggio. Il volume viene visualizzato sull'indicatore di
volume della traccia.

Per regolare il volume di una traccia:

1 Individuare il percorso dell’apposita esercitazione facendo clic su "Loop 1 Vol + Pan" nella finestra
Memory Locations. Vengono visualizzate soltanto la fila di canali "loopl" e la striscia di canali Master Fader.

2 Fare clic sul fader del volume sulla striscia di canali "loopl1" e spostarlo verso I'alto o verso il basso
a seconda che si desideri aumentare o diminuire il volume.

Finestra Memory Locations

aumento volume

®

fare clic su Loop 1 Vol o
riduzione volume

+ Pan per spostarsi
nel percorso
dell'esercitazione
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Esecuzione del pan delle tracce

Si provi ora a eseguire il pan della stessa traccia. Per procedere, fare clic sul dispositivo di scorrimento
Pan e trascinarlo verso sinistra o destra, a seconda che si desideri indirizzare I'audio verso l'una o l'altra
direzione del campo stereo.

Per regolare il pan di una traccia:

= Fare clic sul dispositivo di scorrimento Pan e trascinarlo verso destra o sinistra a seconda che si
desideri indirizzare il pan della traccia a destra o a sinistra nel missaggio.

afic
rel
r
2

sinistra destra

Automazione del missaggio

Attivando la modalita di automazione é possibile controllare i movimenti di fader, dispositivi di
scorrimento e altri controlli del programma di missaggio di Pro Tools LE e far si che vengano ripetuti
automaticamente durante la riproduzione della sessione, come se pit mani azionassero i controlli
contemporaneamente durante il missaggio.

Scrittura di un'automazione

Si provi, ad esempio, a scrivere un'automazione per chitarre. Fare clic sulla posizione di memoria
"Guitar Vol Auto”, quindi scegliere Play nella finestra Transport. Nella fase preliminare alcune tracce
vengono silenziate per consentire di sentire meglio il missaggio tra chitarre, bassi e batteria. Se si
prova prima a missare i volumi delle chitarre nello stesso modo in cui € stato missato il volume di
"loopl", si nota che ciascun fader torna nella posizione iniziale appena viene rilasciato.

Cominciare con la traccia "cleangtr" e impostare la modalita di automazione su Auto Write, quindi
scorrere il fader del volume durante la riproduzione per eseguire la scrittura dell'automazione del
volume. Per ascoltare il risultato dell'automazione, ritornare alla modalita Auto Read. Ripetere la
stessa operazione con la traccia "dirty1".
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Per scrivere un'automazione:

1 Fare clic su "Guitar Vol Auto" nella finestra Memory Locations per spostarsi nel percorso
dell'esercitazione.

2 All'interno della traccia "cleangtr" fare clic sul pulsante Automation mode e scegliere Auto Write dal
menu visualizzato.

3 Fare clic su Play nella finestra Transport. Viene avviata la scrittura dell'automazione della traccia
prescelta. Fare scorrere il fader del volume per registrarne le modifiche nell'automazione.

4 Al termine della scrittura fare clic su Stop.

selezionare Auto Write
come modalita di
automazione

Finestra Memory Locations

®

missando il volume durante la
riproduzione viene eseguita la scrittura
dell'automazione nella sessione

fare clic su Guitar Vol
Auto per spostarsi
nel percorso
dell'esercitazione

Per riprodurre I'automazione:

1 Reimpostare la modalita di automazione della traccia "cleangtr" su Auto Read. A questo punto
lI'automazione viene letta durante la riproduzione della traccia.

2 Riprodurre il brano musicale. L'automazione viene ripetuta durante la riproduzione del brano
musicale. Il fader del volume nella finestra Mix si muovera automaticamente durante la riproduzione
visualizzando l'automazione.

Si puo ora eseguire la scrittura dell'automazione del volume per la traccia della chitarra distorta
"dirty1" seguendo la stessa procedura.

Esecuzione del missaggio nella finestra Edit

La finestra Edit pu0 essere utilizzata per diverse operazioni di editing, oltre a consentire I'accurata
scrittura di automazioni di missaggi. Nella finestra Edit verra eseguita un'aggiunta all'automazione
che é stata scritta nella finestra Mix, inserendo una dissolvenza al termine del brano mediante il
Master Fader.
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Scrittura di un'automazione nella finestra Edit

Nella finestra Edit e possibile visualizzare diversi dati di una traccia, quali la forma d'onda reale,
lI'automazione di volume, mute e pan e cosi via. Nell'esempio seguente verra visualizzato il Master
Fader che controlla il volume dell’intero missaggio e chiude in dissolvenza la parte finale del brano
fino al silenziamento.

Per scrivere una dissolvenza di volume nella finestra Edit:

1 Fare clic sulla posizione di memoria "Out Vamp". Quindi spostarsi nella finestra Edit scegliendo
Windows > Show Edit.

2 Aumentare l'altezza della traccia Master Fader facendo clic sul Selettore altezza traccia e scegliendo
Medium dal menu visualizzato. (Vedere la parte inferiore della figura riportata sotto.) Questa modifica
rendera piu semplice la scrittura della dissolvenza.
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Finestra Edit della posizione di memoria "Out Vamp".

3 Utilizzando lo strumento Grabber, fare clic sul punto della linea del volume in cui di desidera inserire
la dissolvenza. Sulla linea del volume viene visualizzato un punto. Se si desidera rimuovere un punto dalla
linea del volume, farvi clic sopra e premere il tasto Opzione in Macintosh oppure il tasto Alt in Windows.
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4 Utilizzando ancora lo strumento Grabber fare clic sul punto in cui si desidera terminare la
dissolvenza (punto di silenzio) quindi trascinarlo fino al termine della traccia.

dissolvenza del volume completata sul Master Fader
strumento Grabber

T

-

inizia la dissolvenza terminaladissolvenza
in questo punto / qui (silenzio)

5 E possibile modificare i punti di inizio e fine della dissolvenza facendovi clic sopra e trascinandoli
verso destra o verso sinistra.

Plug-in

Pro Tools LE contiene una serie di plug-in Real Time AudioSuite (RTAS) che possono essere utilizzati
per I'elaborazione delle tracce audio. | plug-in RTAS vengono utilizzati per la realizzazione di effetti
ricorrenti, quali I'equalizzazione, la compressione e il ritardo.

Utilizzo dei plug-in

I plug-in vengono agganciati alle tracce mediante uno dei cinque insert presenti su ciascuna fila di
canali. Un insert (lo spiega la parola stessa) inserisce I'effetto del plug-in nel percorso audio.

E possibile aggiungere un plug-in nella finestra Mix facendo doppio clic sull'insert di una traccia e
scegliendo il plug-in desiderato dal menu a comparsa. Questa operazione si puo eseguire durante o al
termine della riproduzione. E possibile aggiungere pit istanze diverse di un plug-in all'interno della
stessa sessione, a seconda della potenza di calcolo del sistema. Ad esempio, nella sessione demo viene
utilizzato per tre volte il plug-in 4-band EQ. Una volta inserito un plug-in in un insert, ¢ possibile
aprirlo per visualizzarne e regolarne le impostazioni facendo doppio clic sul relativo nome che appare
a fianco dell'insert.

plug-in: fare clic su questo selezionare un plug-in selezionando un insert non
pulsante per visualizzare e utilizzato o selezionare no insert per rimuovere un plug-in
modificare le impostazioni == T
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insert io y|  Compressor (mona)

Lirniter (mono)

Expander—Gate (maono)

Gate (mono]

DeEsser (mono)

Sl Sl 1-Band EQ 1l (mono)
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Un esempio

Nella sessione demo di "Be There" sono gia attivati diversi plug-in. In questo esempio si provera a regolare
il plug-in EQ della traccia "VOX". Innanzitutto occorre trovare la giusta posizione di memoria in cui
ascoltare le voci. Conviene cominciare dal verso iniziale. Poiché la traccia "VOX" non appare, occorrera
visualizzarla facendo clic sull'elenco di tracce Show/Hide nella parte sinistra della finestra Mix.

Per modificare le impostazioni dei plug-in:

1 Visualizzare la finestra Mix scegliendo Windows > Show Mix. Fare clic sulla posizione di memoria
"Verse 1".

2 Per visualizzare la traccia vocale, fare clic su "VOX" nell'elenco di tracce Show/Hide.

©)

fare clic su "Verse 'ﬁ":: Gtr-Ls7?

1" nella finestra dirtwgtr1 @

Memory Locations cleangtr
wox fare clic per visualizzare la traccia
. (il nome della traccia & evidenziato)

3 Visualizzare il plug-in facendo clic sul relativo nome a fianco dell'insert.

4 Fare clic su Play nella finestra Transport, quindi regolare le impostazioni del plug-in, ascoltando le
modifiche apportate all'audio. Provare tutte le variazioni desiderate

5 Al termine chiudere il plug-in facendo clic sulla casella di chiusura.

fare clic su 4-Band EQ
sull'insert del canale
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Assolo

Potrebbe risultare piu semplice regolare il plug-in di una traccia ascoltando soltanto questa. Questa
operazione viene definita assolo di una traccia.

Per selezionare I'assolo di una traccia:

1 Fare clic sul pulsante Solo nella fila di canali. Riprodurre il brano.

2 Al termine fare clic nuovamente sul pulsante Solo per riascoltare I'intero missaggio.

Q E possibile selezionare I'assolo di piti canali facendo clic sui relativi pulsanti Solo.

Trucchi del missaggio: big mute

Nella presente carrellata illustrativa di funzioni di missaggio di Pro Tools LE pu0 essere interessante
inserire un trucco utilizzato spesso per brani musicali di genere diverso detto "big mute"
(silenziamento esteso). 1l "big mute" consiste nel silenziamento automatico di un gruppo di tracce e
viene utilizzato per dare risalto a una breve sezione del brano musicale. Questo punto del missaggio
viene scritto come automazione di silenziamento per tutte le tracce che utilizzano un gruppo di
automazione gia impostato.

Q Per una migliore comprensione del big mute, fare riferimento alle informazioni relative
all'automazione del missaggio e ai gruppi nella Guida di riferimento di Pro Tools. Questo
trucco rappresenta soltanto un esempio delle infinite possibilita di missaggio disponibili
con Pro Tools LE.

Per automatizzare il big mute:

1 Spostarsi nel percorso dell'esercitazione facendo clic su "Big Mute" nella finestra Memory Locations.

2 Per attivare il gruppo del big mute, fare clic sulla colonna a sinistra della voce Big Mute nell'elenco
Groups.

IMis Grouesly

o L <Al e

®

H . N q all voc
@ fare clic per attivare il Lo b Big Mu
gruppo "Big Mute" i Sampld
fare clic sulla
posizione di

memoria "Big Mute" [v
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3 Impostare la modalita di automazione su Auto Write per la traccia slap return "SIpRt" facendo clic
sul pulsante Automation mode e scegliendo Auto Write dal menu a comparsa visualizzato. Con
questa operazione verra automatizzato il silenziamento della traccia slap return, che inserisce un
ritardo nella voce principale.

4 Fare clic su Play nella finestra Transport, quindi scegliere Mute sulla traccia per avviare la scrittura
dell'automazione del silenziamento.

5 Fare nuovamente clic su Mute per interrompere la scrittura prima che cominci I’esecuzione della
voce principale nella seconda parte del coro (ovvero, prima del verso "but when she comes around").

6 Fare clic sul pulsante Stop nella finestra Transport per interrompere la scrittura dell'automazione.
Q Quando si interrompe la riproduzione, la modalita di automazione passa

automaticamente a "Auto Touch". Questa modalita serve a "ritoccare” I'automazione
registrata e viene descritta nella Guida di riferimento di Pro Tools.

®

impostare la modalita di
automazione su Auto Write @

selezionare il Mute durante la riproduzione per
scrivere I'automazione del silenziamento

7 Reimpostare la modalita di automazione della traccia "SIpRt" su Auto Read, fare clic su Play nella
finestra Transport, quindi ascoltare il risultato. Durante la riproduzione del coro non si dovrebbe
rilevare alcun ritardo nelle voci. Fare clic su Stop al termine dell'ascolto.

8 Per impostare la modalita di automazione Auto Write per il gruppo Big Mute, fare clic sul pulsante
Automation mode di una traccia qualsiasi del gruppo (ad esempio, cleangtr) e scegliere Auto Write dal
menu a comparsa. Questa operazione attiva la modalita Auto Write per tutte le tracce del gruppo.

9 Riprodurre la sessione e fare clic sul pulsante Mute su una traccia qualsiasi del gruppo Big Mute
abilitata per la modalitad Auto Write (ad esempio, "clngtr"). Viene avviata la scrittura dell'automazione
Mute per tutte le tracce. Provare a fare clic sul pulsante Mute nel punto di inizio della misura 109 ("she
says when she [mute] comes around") per ottenere un effetto di maggiore impatto.
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10 Per interrompere la scrittura dell'automazione del silenziamento, fare nuovamente clic sul
pulsante Mute della stessa traccia. Provare a fare clic sul pulsante verso l'inizio della misura 113 ("but
when she [no mute] comes around").

attivare la modalita
di automazione
Auto Write fare clic sul pulsante Mute di
una traccia del gruppo durante
la riproduzione per awviare la
scrittura dell'automazione del

silenziamento

11 Riportare il gruppo Big Mute in modalita Auto Read, quindi fare clic su Play nella finestra
Transport per ascoltare il Big Mute.

Se il primo tentativo non da buoni risultati, &€ possibile annullare il silenziamento scegliendo Edit >
Undo, quindi riprovare.
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MIDI

Questa sezione facoltativa é riservata agli utenti MIDI. In questa sezione viene spiegato come
collegare un dispositivo MIDI al dispositivo I/0 Digi 001 per realizzare effetti sonori degni di nota con
tracce MIDI nella sessione demo.

La configurazione MIDI viene eseguita in OMS (Open Music System) nei sistemi Macintosh e in
Impostazioni multimediali in Windows.

Macintosh

Durante l'installazione di Digi 001, il driver di Digi 001 viene collocato all’interno della cartella OMS.
Per utilizzare questo driver, occorre collegare il dispositivo e configurare I'applicazione OMS Studio
Setup. Per ulteriori informazioni vedere la sezione "Installazione e configurazione di OMS" a pagina 9.

Windows

Durante l'installazione di Digi 001, viene installato anche il driver MIDI Digi 001. Per utilizzare
questo driver, occorre collegare il relativo dispositivo e configurare le Impostazioni multimediali di
Windows. Per ulteriori informazioni vedere la sezione "Installazione dei driver Wave di Windows" a
pagina 19.

Offset MIDI

Quando si esegue il monitoraggio di un dispositivo MIDI mediante ingressi audio di Digi 001
mediante tracce attivate per la registrazione, si verifichera un ritardo audio pari al numero di
campioni specificati nelle impostazioni del buffer hardware (vedere "Latenza di monitoraggio e
registrazione" a pagina 69). Tale ritardo audio & detto latenza. E possibile neutralizzare questa latenza
attivando i dati MIDI in anticipo, utilizzando MIDI Offset. Per ulteriori informazioni consultare la
Guida di riferimento di Pro Tools.
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Collegamento e configurazione di un dispositivo MIDI

Per collegare un dispositivo MIDI:

1 Collegare la porta MIDI In del dispositivo I/0O Digi 001 al connettore MIDI Out della periferica e la
porta MIDI Out del dispositivo I/0 Digi 001 alla porta MIDI In della periferica mediante cavi MIDI a
5-pin standard.

2 Collegare l'uscita o le uscite audio della periferica.

= E possibile collegare l'uscita audio del dispositivo a Digi 001 collegando le uscite analogiche agli
ingressi analogici sulla parte posteriore del dispositivo 1/0 Digi 001; nel caso di un dispositivo
digitale é possibile collegarlo agli appositi ingressi digitali del dispositivo I/0 Digi 001 o della
scheda PCI Digi 001. Se si sta eseguendo il monitoraggio del dispositivo attraverso gli ingressi audio
Digi 001, occorrera indirizzare ciascun ingresso a una traccia e attivare quest'ultima per la
registrazione in modo da poterla ascoltare (per le istruzioni vedere Capitolo 6, "Registrazione").

= E anche possibile monitorare il dispositivo tramite un mixer separato che supporti ingressi
analogici o digitali, quindi eseguire il routing dell'uscita verso gli ingressi audio Digi 001 quando si

€ pronti per la registrazione audio. Per ulteriori informazioni leggere la documentazione relativa al
mixer.
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Installazione di base di un dispositivo MIDI utilizzando un mixer hardware esterno
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Utilizzo di un dispositivo MIDI con la sessione demo

Per comprendere come assegnare uno strumento MIDI a una traccia in Pro Tools LE, si provi ad
assegnare uno strumento a una traccia MIDI contenuta nella sessione demo. Questa operazione verra
eseguita con la traccia "Virusplayed". Mediante appositi programmi sara possibile riprodurre la traccia
MIDI con sintetizzatori o altri dispositivi.

Assegnazione di un dispositivo MIDI per la riproduzione della traccia "Virusplayed™:
1 Fare clic sulla posizione di memoria "Tutorial Start" per spostarsi all'inizio dell'esercitazione.

2 Per nascondere tutte le tracce, utilizzare il menu Show/Hide Tracks List e scegliere I'opzione per
nascondere tutte le tracce, quindi fare clic su "Virusplayed".

E - fare clic qui per
@t | selezionare il dispositivo
) . . ? MIDI (al momento
fare clic per aprire. —{FanawrHide Mirus Fx 1 == “nessuno”)
il menu Show/Hide - Slap Rtn -
kick Master 1 )
snare Virusplaye fare clic per visualizzare | £45%
Kit.L S0 In la traccia "Virusplayed"
Tablas 5C
haracasc

Show Al Tracks
Show Only Selected Tracks

Hide Selected Tracks E I

Indicatore della
traccia MIDI

3 Fare clic sul selettore di canale/dispositivo MIDI della traccia e assegnare un dispositivo e un canale
dal menu a comparsa.

4 Fare clic su Play nella finestra Transport per ascoltare mediante il dispositivo MIDI la riproduzione
della linea del sintetizzatore MIDI registrata sulla traccia "Virusplayed".

Numerose altre funzionalita sono disponibili con MIDI, Pro Tools LE e Digi 001. Per ulteriori
informazioni consultare la Guida di riferimento di Pro Tools.
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Registrazione

In questa sezione viene spiegato come registrare tracce audio e MIDI mediante Pro Tools LE.

Indirizzamento del segnale audio a una traccia

Per indirizzare il segnale audio a una traccia:

1 Collegare le sorgenti sonore. Per ulteriori informazioni vedere "Collegamento delle sorgenti audio
all'unita Digi 001" a pagina 32.

2 Creare le tracce sulle quali si desidera registrare scegliendo File > New Track.

3 Nella finestra Edit o Mix, individuare il riquadro 1/0. Se non ¢ visibile, & possibile visualizzare
questo riquadro scegliendo Display > Edit Window Shows > 1/0 View dalla finestra Edit oppure
Display > Mix Window Shows > 1/0 View dalla finestra Mix.

4 Fare clic sul pulsante Input.

5 Dal menu a comparsa selezionare l'ingresso in uso. Per esempio, specificare Mic/Line 1 se la
sorgente sonora é collegata all'ingresso analogico 1 oppure specificare Optical 7 se si utilizza I'ingresso
ottico 7.

Ingressi analogici

Ingressi ottici (ADAT)

it [|— ingressi Rea (s/PDIF)

Indirizzamento di un ingresso a una traccia
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Impostazione dei livelli in ingresso di Digi 001

I livelli in ingresso di Digi 001 per gli ingressi analogici 1 e 2 sono regolati mediante le manopole di
guadagno sul dispositivo 1/0 Digi 001 per ciascun canale. Il software dei livelli in ingresso per gli
ingressi analogici 3-8 & regolabile per ricevere i livelli in uscita di diverse apparecchiature.

L'elemento chiave nell'impostazione dei livelli in ingresso consiste nell’ottenere un segnale molto
forte senza produrre clipping digitale. | segnali che si avvicinano ai valori piu elevati del meter in
Pro Tools LE utilizzano una parte maggiore della gamma in bit completa (16 o 24 bit per ciascun
campione audio). Maggiore € lagamma in bit, migliore risulta la qualita del suono. Impostando livelli
ottimali € possibile ridurre al minimo il rumore e la distorsione.

Fare attenzione al clipping digitale. 1l clipping viene prodotto quando si invia a un dispositivo audio
un segnale piu forte di quello supportato dalla circuiteria. 1l risultato é la distorsione del suono. In
genere non é piacevole sentire il clipping digitale, quindi si consiglia di tenere sotto controllo i meter.

Q Per un rapporto segnale/rumore ottimale impostare il livello in ingresso dell'interfaccia
" Digi 001 su +4 dBu quando si registrano dispositivi che forniscono questo livello in
uscita.

Per regolare il guadagno in Digi 001 (ingressi 1-2 mic/line):

1 Collegare lo strumento o il microfono all'ingresso.

2 Se il microfono richiede I'alimentazione phantom, attivarla premendo il pulsante 48V.

3 Creare una traccia di ingresso ausiliario scegliendo File > New Track.

4 Impostare l'ingresso della traccia sul canale di ingresso Digi 001 corretto (mic/line 1 o 2).
5 Riprodurre la sorgente strumentale o sonora al volume di registrazione.

6 Collegare il guadagno in ingresso per il canale mediante la manopola di guadagno che si trova sulla
parte anteriore del dispositivo I/0 Digi 001. Aumentare o diminuire il guadagno fino a raggiungere il
livello massimo del segnale senza clipping. Generalmente questi livelli sono compresi nell'area gialla
del meter della traccia.

2

a®

MiciLine 2648 Gain

Guadagno in aumento

Per regolare il guadagno in ingresso in Digi 001 (ingressi analogici 3-8):
1 Collegare lo strumento o il dispositivo all'unita I/0 Digi 001.
2 In Pro Tools LE selezionare Setups > Hardware.

3 Fare clic su Other Options.
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4 Impostare il dispositivo di scorrimento del trimming in ingresso in modo che corrisponda al livello in
uscita dello strumento collegato. Per ulteriori informazioni consultare la documentazione del produttore.
Se non si conosce il livello in uscita del dispositivo, utilizzare il livello predefinito di trimming in ingresso,
quindi regolare il guadagno del livello in ingresso utilizzando la procedura descritta di seguito.

5 Fare clic su Done quindi su OK.

Q L'aumento del guadagno fa aumentare la soglia di rumore inferiore. Verificare che il
" dispositivo collegato produca un segnale molto forte senza distorsione, quindi impostare il
guadagno in ingresso di conseguenza.

Per ottimizzare il guadagno del livello in ingresso (ingressi analogici 3-8):

1 Creare una traccia di ingresso ausiliario scegliendo File > New Track. La traccia pud essere mono o
stereo a seconda del dispositivo che si sta monitorando. Premere i tasti Opzione (Macintosh) o Alt
(Windows) sul fader della traccia per impostarlo su un valore di guadagno unitario (0 dB).

2 Impostare I'ingresso della traccia sui canali di ingresso Digi 001 o corretti.
3 Riprodurre lo strumento al volume di registrazione.

4 Osservare dove viene rilevato il segnale in uscita dello strumento sui misuratori sullo schermo di
Pro Tools LE. I livelli "accettabili” rientrano nell'area gialla del meter di tracce Pro Tools LE. Se i livelli
raggiungono il rosso, si sta verificando il clipping e quindi occorre abbassare il guadagno in ingresso.

5 Se i meter non producono clipping e non raggiungono l'area gialla, scegliere Setups > Hardware e
fare clic su Other Options per aumentare il guadagno in ingresso spostando verso I'alto il dispositivo
di scorrimento del volume per I'ingresso desiderato. Fare clic su Done e riprodurre nuovamente la
sorgente sonora. Ripetere I'operazione fino a ottenere un segnale forte senza clipping.

6 Ripetere questa operazione fino a raggiungere il livello massimo del segnale senza clipping.

ingresso

non occorre attivare
una traccia aux per la
registrazione

attivato per la registrazione

attivato per la registrazione la luce rossa luminosa indica il clipping

(fader rosso) impostare qui i picchi di ingresso

impostare qui i picchi
di ingresso

Impostazione dei livelli di ingresso di registrazione (traccia Aux a sinistra, traccia disco a destra)
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7 Regolare il guadagno nei canali analogici 3-8 mediante Other Options dalla finestra di dialogo
Hardware Setup (Setups > Hardware, quindi fare clic su Other Options).

guadagno negli ingressi analogici 3-8
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Finestra di dialogo Other Options

NOTA: non ¢ possibile regolare il guadagno per ingressi digitali, a meno che non sia possibile regolarlo alla
sorgente.

Filtro Mic/Line High-Pass

Digi 001 comprende un filtro passa alto impostato a 60 Hz. Questo filtro pud servire a eliminare i
rumori di bassa frequenza da un ambiente di registrazione rumoroso o da un handling di microfono
oppure da rumore AC.

Per utilizzare il filtro passa alto o I'ingresso analogico 1 o 2:

1 Scegliere Setups > Hardware e fare clic su Other Options.

2 Attivare il filtro passa alto per gli ingressi desiderati.

Registrazione di una traccia audio

Per registrare una traccia audio:

1 Attivare la registrazione della traccia desiderata e assegnarvi un ingresso. Impostare correttamente
i livelli di ingresso.

2 Visualizzare la finestra Transport (Windows > Show Transport) e fare clic su Return to Zero per
assicurarsi di cominciare la sessione dall'inizio. E inoltre possibile registrare in base a una selezione o
alla posizione del cursore nella finestra Edit (vedere le figure riportate di seguito).

3 Fare clic sul pulsante di registrazione nella finestra Transport per attivare la registrazione.

4 Fare clic su Play o premere la barra spaziatrice per registrare su tutte le tracce attivate per la
registrazione.
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5 Cominciare a suonare lo strumento.

6 Fare clic su Stop nella finestra Transport o premere la barra spaziatrice al termine della registrazione.

Return to Zero fare clic per fare clic per attivare la registrazione
registrare dall'inizio della sessione (diventa rosso luminoso)

Hmr e

Registrazione dall'inizio di una sessione

@ fare clic sullo strumento Selector

la freccia rossa indica che

__'| n.r. E'-': Fj Eﬂq’ 7 #_ la registrazione inizia dalla
o A [ R posizione del cursore

posizionare il cursore
dove si desidera iniziare —
la registrazione

@ attivare la registrazione
di una traccia

@ fare clic per attivare la registrazione
(diventa rosso luminoso)

@ fare clic su Play per iniziare la registrazione

Registrazione dalla posizione del cursore nella finestra Edit
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fare clic sullo strumento Selector

M queste frecce che contrassegnano la selezione

diventano rosse per indicare che la registrazione
verra eseguita nell'area selezionata

@ attivare la registrazione

A @ selezionare la
di una traccia durata che si —

desidera registrare

@ fare clic per attivare la registrazione
(diventa rosso luminoso)

@ fare clic su Play per iniziare la registrazione

Registrazione della durata di una selezione nella finestra Edit

Per riprodurre una traccia registrata:

1 Disattivare la registrazione sulla traccia facendo nuovamente clic sul pulsante Record per questa
traccia. Il pulsante non dovrebbe essere evidenziato.

2 Fare clic su Play nella finestra Transport o premere la barra spaziatrice per riprodurre la traccia.

3 Fare clic sul pulsante Stop nella finestra Transport oppure premere la barra spaziatrice per
interrompere la riproduzione.
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Latenza di monitoraggio e registrazione

Poiché in Pro Tools LE viene utilizzato il processore host del computer per I'elaborazione, la
riproduzione e laregistrazione audio, nel sistema si verifica un piccolo ritardo audio o latenza quando
si sta monitorando l'audio nel sistema. E possibile impostare una latenza pitl corta durante la
registrazione o il monitoraggio di Digi 001 e piu lunga quando si cerca di ottenere piu tracce con piu
plug-in.

Effetto delle impostazioni del buffer hardware sulla latenza di monitoraggio audio

Frequenza di Impostazione Latenza Utilizzare questa impostazione per:
campionamento | buffer (campioni) | (ms)

44,1 kHz 128 29 registrazione di percussioni e altri strumenti per i
quali la sincronizzazione é cruciale

256 5,8 registrazione di voci e strumenti con attacco piu
lento
512 11,6 missaggio con 24 tracce
1024 23,2 missaggio finale o numerosi plug-in
2048 46,4 missaggio finale o numerosi plug-in
4096 92,8 missaggio finale o numerosi plug-in
8192 185,5 missaggio finale o numerosi plug-in
48 kHz 128 2,7 registrazione di percussioni e altri strumenti per i

quali la sincronizzazione é cruciale

256 5,3 registrazione di voci e strumenti con attacco piu
lento

512 10,7 missaggio con 24 tracce

1024 21,3 missaggio finale o numerosi plug-in

2048 42,7 missaggio finale o numerosi plug-in

4096 85,3 missaggio finale o numerosi plug-in

8192 170,7 missaggio finale o numerosi plug-in

Impostare la latenza nella finestra di dialogo Hardware Setup. La latenza € controllata
dall'impostazione della dimensione del Buffer H/W e viene visualizzata nei campioni. L'impostazione
consigliata per ascoltare l'audio € 512-1024 campioni. Per registrare durante il monitoraggio in

Digi 001, I'impostazione consigliata &€ 128-256 campioni.

A\ Se si dispone di una scheda SampleCell 11 Plus, si consiglia di non utilizzare la
dimensione di buffer 128 quando si esegue SampleCell Editor contemporaneamente a
Pro Tools LE. Utilizzare un'impostazione del buffer maggiore per evitare risultati errati.
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Per impostare le dimensioni del buffer hardware per la registrazione o la riproduzione:
1 Scegliere Setups > Hardware.

2 Scegliere il numero di campioni dal menu a comparsa H/W Buffer Size, quindi fare clic su OK.

Funzione Low Latency Monitoring

Pro Tools LE comprende una funzione chiamata Low Latency Monitoring per sistemi Digi 001. Questa
funzione consente di utilizzare un mixer integrato sulla scheda PCI Digi 001 per registrare e monitorare
fino a 16 ingressi (8 analogici e 8 ADAT) con una latenza estremamente bassa. Questa modalita puo essere
molto appropriata per la registrazione di piu strumenti contemporaneamente o di un gruppo musicale.

Per attivare la funzione Low Latency Monitoring:
» Selezionare Operations > Low Latency Monitoring.

Per utilizzare I'opzione Low Latency Monitoring € necessario attivare la registrazione delle tracce,
assegnarle a un ingresso audio reale (non a un bus) e assegnarle alle uscite 1 o 2.

Quando la funzione Low Latency Monitoring ¢ attivata, tutti i plug-in e le mandate assegnate a tracce
attivate per la registrazione (indirizzate alle uscite 1-2) vengono automaticamente ignorate e devono
rimanere tali. Inoltre queste tracce non verranno rilevate sui meter per i Master Fader.

Registrazione MIDI

Per configurare una nuova traccia MIDI per la registrazione:

1 Scegliere File > New Track e specificare 1 MIDI Track, quindi fare clic su Create.

2 Nella finestra Mix fare clic sul selettore di dispositivo/canale MIDI della traccia e assegnare un
dispositivo e un canale dal menu a comparsa.

channel-1
channel-2
channel-2
channel-4 ..
channel-5
channel-&

Selettore dispositivo MIDI/canale

3 Se lo si desidera, € possibile assegnare una modifica di programma predefinito alla traccia. Nella
finestra Mix fare clic sul pulsante Program (Prog) ed effettuare le selezioni necessarie per la selezione
del banco e del programma e quindi fare clic su Done. Le modifiche al programma predefinito sono
inviate quando si riproduce una traccia.

4 Nella finestra Mix fare clic sul pulsante Record della traccia MIDI per attivare la traccia per la
registrazione.
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Monitoraggio degli strumenti MIDI senza un mixer

Se si utilizza il sistema Digi 001 senza una console di missaggio esterna, sara necessario creare un
ingresso ausiliario per monitorare lo strumento MIDI. Gli ingressi ausiliari funzionano come ingressi
per segnali inviati internamente mediante bus e per sorgenti audio esterne.

Per configurare un ingresso ausiliario per il monitoraggio MIDI:
1 Collegare l'uscita dello strumento MIDI all'ingresso appropriato del dispositivo I/0O Digi 001.
2 Scegliere File > New Track e specificare 1 Aux Input track, quindi fare clic su Create.

3 Fare clic sul selettore dell'ingresso del canale dell'ingresso ausiliario e scegliere I'ingresso al quale &
collegato lo strumento MIDI.

4 Fare clic sul selettore di uscita del canale dell'ingresso ausiliario e scegliere un'uscita.

5 Regolare il livello dell'ingresso ausiliario con il fader del volume.

Per registrare nella nuova traccia MIDI:

1 Scegliere MIDI >Input Devices e assicurarsi che il dispositivo MIDI sia selezionato.

2 Verificare che MIDI > MIDI Thru sia selezionato e quindi riprodurre alcune note sul controller MIDI.
Lo strumento MIDI assegnato alla traccia dovrebbe suonare e i meter della traccia dovrebbero
registrare l'attivita MIDI.

3 Nella finestra Transport fare clic sul pulsante Return to Zero, per azzerare i tempi iniziale e finale.
In questo modo la registrazione incomincera dall'inizio della traccia.

4 Fare clic sul pulsante di registrazione nella finestra Transport.

< Se si utilizza I'opzione Wait for Note, i pulsanti Play, Record e Wait for Note lampeggiano. La
registrazione inizia quando viene ricevuto il primo evento MIDI.

= Se si utilizza Countoff, fare clic su Play. | pulsanti di registrazione e riproduzione lampeggiano
durante il conteggio, dopodiché ha inizio la registrazione.

5 Una volta terminata la registrazione, fare clic su Stop nella finestra Transport. | dati MIDI appena
registrati vengono visualizzati come una regione MIDI nella finestra Edit e nell'elenco delle regioni
MIDI.

Per riprodurre una traccia MIDI registrata:

1 Fare clic sul pulsante Record Enable della traccia MIDI per disattivare la modalita di registrazione
pronta.

2 Nella finestra Transport fare clic sul pulsante Return to Zero.

3 Fare clic sul pulsante di riproduzione nella finestra Transport per iniziare la riproduzione. | dati
MIDI registrati vengono riprodotti mediante lo strumento e il canale assegnato della traccia.
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Registrazione mediante footswitch

E possibile utilizzare un footswitch standard (per esempio, un pedale synth sustain) con QuickPunch
per effettuare il punch in durante la registrazione audio. E inoltre possibile eseguire il punch in per la
registrazione MIDI, senza attivare il QuickPunch. Per ulteriori informazioni sulla registrazione punch
consultare la Guida di riferimento di Pro Tools.

In Pro Tools LE il footswitch viene rilevato solo se € collegato al dispositivo I/0O Digi 001 prima di
avviare Pro Tools LE.

Per collegare un footswitch a Digi 001:

= Collegare un footswitch al connettore Footswitch sul retro del dispositivo I/0 Digi 001.

. Q0O
0000 MONITOR INPUT K n 7
| .. ....

weUTs  weuTe ey 4 outus  oueurs

SPoE

collegare il footswnch qui

Per effettuare il punch in durante la registrazione audio con QuickPunch:

1 Attivare QuickPunch (Operations > QuickPunch).

2 Impostare I'indirizzamento dell'ingresso e fare clic sul pulsante Record su ciascuna traccia audio
sulla quale si desidera effettuare il punch in. E possibile effettuare il punch in su un massimo di 8
tracce audio mentre si riproducono 24 tracce oppure si puo effettuare il punch in su un massimo di
16 tracce mentre si riproducono 16 tracce.

3 Fare clic su Play nella finestra Transport. Premere il footswitch per iniziare la registrazione (punch
in) su tutte le tracce attivate per la registrazione. Premere nuovamente il footswitch per interrompere
la registrazione (punch out).

Notare che la riproduzione continua nella sessione ed & possibile continuare a effettuare il punch in
e il punch out mediante il footswitch tutte le volte che si desidera.

Per effettuare il punch in durante la registrazione MIDI:

1 Impostare lI'indirizzamento dell'ingresso MIDI e fare clic sul pulsante Record su ciascuna traccia
audio sulla quale si desidera effettuare il punch in. QuickPunch non ¢ richiesto per il punch in su
tracce MIDI.

2 Fare clic su Play nella finestra Transport. Premere il footswitch per iniziare la registrazione (punch
in) su tutte le tracce attivate per la registrazione. Premere nuovamente il footswitch per interrompere
la registrazione (punch out).
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Registrazione verso e da un dispositivo ADAT

E possibile utilizzare Digi 001 in combinazione con un dispositivo ADAT, per registrare tracce
provenienti da quest'ultimo con Pro Tools LE oppure per registrare tracce da Pro Tools LE con un
dispositivo ADAT.

Utilizzo di coppie di uscite

In base al funzionamento delle uscite in Pro Tools LE, ciascuna traccia cerca una coppia di uscite
stereo. Questo significa che per registrare su otto tracce ADAT, occorre inviare 4 coppie di tracce
Pro Tools LE (ciascuna coppia impostata con pan tutto a sinistra e tutto a destra) a 4 coppie di uscite
ADAT ottiche digitali in Digi 001.

Per registrare tracce ADAT in Pro Tools LE:
1 Collegare il connettore Optical Out nel deck ADAT al connettore Optical In sul retro della scheda
PCI Digi 001.

Alesis ADAT

00000000
00000000

Scheda PCI Digi 001

i | ==
all'uscita Optical \é
< Out ADAT

all'ingresso Optical In della
scheda PCI Digi 001

00 @ @

Collegamento dell'uscita ottica ADAT all'ingresso ottico della scheda PCI Digi 001
2 Aprire o creare una sessione in Pro Tools LE.

3 Attivare per la registrazione fino a 8 tracce audio (in base a quante tracce sono state utilizzate sul
nastro ADAT).

4 Assegnare gli ingressi ottici ADAT 1-8 alle otto tracce.
5 Fare clic sul pulsante di registrazione nella finestra Transport.

6 Fare clic su Play nella finestra Transport per cominciare la registrazione, quindi premere Play sul
dispositivo ADAT.

7 Al termine della riproduzione dal nastro ADAT, fare clic su Stop nella finestra Transport oppure
premere la barra spaziatrice.
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Per registrare le tracce Pro Tools LE su un nastro ADAT:

1 Collegare il connettore Optical Out ADAT alla retro della scheda PCI Digi 001 con il connettore
Optical In ADAT sul retro del deck ADAT.

Alesis ADAT

Scheda PCI Digi 001

e Cmmm, |

00000000
00000000

38
aII‘ingrei@:)m

In ADAT =
"

00 @ @

all'uscita Optical Out della
scheda PCI Digi 001

2 Aprire la sessione che si desidera registrare sul nastro ADAT.
3 Attivare per la registrazione fino a 8 tracce sul dispositivo ADAT.

4 Eseguire il pan di 4 tracce di modo che ciascuna traccia sia impostata con il pan stereo (una traccia
per coppia & impostata con il pan tutto a sinistra e I'altra ¢ impostata con il pan tutto a destra).

5 Indirizzare ciascuna coppia di tracce verso una coppia distinta di uscite ottiche selezionando una
coppia di uscite per ciascuna traccia dal menu a comparsa Output. Per esempio, se una delle coppie
e 3(L)-4(R), si potrebbe indirizzare questa coppia verso le uscite #1/9 Optical 1-#1/10 Optical 2.

6 Iniziare la registrazione sul nastro ADAT, quindi fare clic su Play nella finestra Transport in
Pro Tools LE. Al termine della registrazione arrestare entrambi i sistemi.
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